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1 Présentation du Makoto Intravascular Imaging SystemÊ 

1.1 Indications dôutilisation  

Le Makoto Intravascular Imaging SystemÊ est destiné à lôexamen du proche infrarouge 

des artères coronaires chez les patients subissant une coronarographie invasive.  

Le système est conçu pour détecter des plaques dôint®r°t contenant un cîur lipidique. 

Le syst¯me est con­u pour ®valuer la masse du cîur lipidique de lôartère coronaire. 

Le système est destiné à lôexamen par ultrasons de la pathologie intravasculaire 

coronarienne. Lôimagerie par ultrasons intravasculaire est indiquée chez les patients 

candidats à des procédures dôintervention coronariennes transluminales. 

 

1.2 Formation 

Le Makoto Intravascular Imaging SystemÊ doit être exclusivement utilisé par le 

personnel du laboratoire de cathétérisme cardiaque et des médecins qualifiés. 

Une formation sur site par le personnel dôInfraredx ou des formateurs certifiés sur 

lôutilisation du Makoto Intravascular Imaging SystemÊ est disponible au moment de 

lôinstallation et sur demande. Veuillez contacter le service clientèle dôInfraredx ou votre 

fournisseur de services local pour planifier des formations sur site et des évaluations 

périodiques des compétences de la formation. 

 

1.3 Coordonnées dôInfraredx 

Aux États-Unis, contactez : 

  
 Infraredx, Inc. 
 28 Crosby Drive, Suite 100 
 Bedford, MA 01730 
 États-Unis 
  
 http://www.infraredx.com 
 1-800-596-3104 
 

  

http://www.infraredx.com/
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1.4 Brevets  

Le Makoto Intravascular Imaging SystemÊ, les cathéters et les accessoires associés 

sont protégés par un ou plusieurs brevets. Pour obtenir une liste exhaustive des brevets 

publiés, veuillez consulter : 

http://www.infraredx.com/infraredx-intellectual-property/ 

1.5 Marques de commerce 

InfraredxÊ, MakotoÊ, DualproÊ, et TVCÊ sont des marques de commerce 

dôInfraredx, Inc. Le nom ç Infraredx Dualpro » est une marque de commerce déposée 

en Chine. Le nom « Infraredx » est une marque déposée d'Infraredx, Inc. aux États-

Unis, dans l'Union européenne, en Australie, en Chine, en Corée du Sud et au Japon. 

Tous les autres noms de marque et noms de produits utilisés et référencés dans ce 

document sont des marques de commerce, des marques déposées ou des noms de 

marque de leurs détenteurs respectifs. 

 

http://www.infraredx.com/infraredx-intellectual-property/
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2 Manière dôinterpréter ce manuel 
Ce manuel contient des informations importantes pour lôutilisation du Makoto 
Intravascular Imaging SystemÊ. Lisez et passez attentivement en revue le manuel 
avant dôessayer dôutiliser le produit.  
 

2.1 Symboles et icônes 

Des alertes sont présentes partout dans ce manuel. Ces alertes sont appelées 

Avertissements, Mises en garde et Remarques. 

AVERTISSEMENT 

Des situations dangereuses, y compris des blessures au patient 
ou à l'opérateur, peuvent se produire si les avertissements 
affichés sont ignorés. 
 

 

ATTENTION 

Le non-respect des mises en garde écrites peut endommager le 
Makoto Intravascular Imaging SystemÊ ou entraîner une 
dégradation des performances du système. 

 

REMARQUE : Les remarques fournissent des rappels et des conseils utiles 
pour lôutilisation des fonctionnalités avancées. 

 

2.2 Abréviations 

 

CA Courant alternatif 

ANSI American National Standards Institute (Institut national de 

normalisation américain) 

ZS Zone de sténose 

AVI Audio Video Interleave (imbrication audio vidéo) 

CABG Pontage aorto-coronaire 

CUI Console User Interface (interface utilisateur de la console) 

CPU Central Processing Unit (unité centrale de traitement) 

DICOM Digital Imaging and Communications in Medicine standard 

(norme pour la gestion informatique des données issues de 

lôimagerie médicale) 
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DVD Digital Video Disc (disque vidéo numérique) 

MEE Membrane élastique externe 

CEM Compabilité électromagnétique 

IEM Interférence électromagnétique 

OE Oxyde dôéthylène 

EtO Oxyde dôéthylène 

FDA Food and Drug Administration 

FHD Full High Definition display (écran haute définition intégrale), 

1920x1080 pixels 

HD High Definition display (écran haute définition) 

CEI Commission électrotechnique internationale 

IP Internet Protocol (protocole Internet) 

ISO International Organization for Standardization 

IVUS Intravascular Ultrasound (échographie intravasculaire) 

JPEG Joint Photographic Experts Group (Groupe mixte dôexperts 

en photographie) 

LCBI Lipid Core Burden Index (indice de masse du cîur lipidique) 

PCL Plaque dôint®r°t contenant un cîur lipidique  

LCBImx LCBI max. dôune largeur de fenêtre spécifiée 

PIR Proche infrarouge  

SPIR Spectroscopie par proche infrarouge 

ZP Zone de plaque 

PP Progression de plaque 

PACS Picture Archiving and Communication System (système 

dôarchivage et de transmission dôimages) 

ACTP Angioplastie coronarienne transluminale percutanée 

RF Radiofréquence 

UL Underwriters Laboratories 

USB Universal Serial Bus (bus universel en série) 
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2.3 Actions 

Le Makoto Intravascular Imaging SystemÊ est principalement conçu pour une 

interaction par écran tactile. En plus de lôécran tactile, le système est équipé dôune 

souris. Souvenez-vous des actions et des gestes suivants pour vous aider à interagir 

avec le Makoto Intravascular Imaging SystemÊ : 

 

Toucher Un contact momentané avec lôécran tactile ou le fait 

dôenfoncer et de relâcher un bouton physique 

Appuyer Appuyer et relâcher un bouton physique 

Cliquer avec le bouton Un seul clic sur le bouton droit de la souris 

droit de la souris 

Cliquer avec le bouton Un seul clic sur le bouton gauche de la souris 

gauche de la souris  

ou Cliquer 

Double-cliquer Deux clics successifs rapides sur le bouton gauche de la souris 

Faire défiler vers Tourner la roulette de défilement sur la souris vers lôutilisateur 

le haut / le bas pour descendre ou dans lôautre sens pour monter 

Faire glisser Quand le doigt est en contact avec une icône mobile, 

déplacer le doigt vers un autre emplacement. Retirer le doigt 

de lôécran pour relâcher lôicône.  
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3 Mises en garde, sécurité et précautions 
 

3.1 Contre-indications 

Lôutilisation du cathéter Makoto Intravascular Imaging SystemÊ est contre-indiquée 
quand lôintroduction dôun cathéter constitue une menace pour la sécurité du patient. Les 
contre-indications incluent : 
 
Á une bactériémie ou septicémie ; 
Á des anomalies majeures du système de coagulation ; 
Á une instabilité hémodynamique grave ou un choc ; 
Á les patients qui sont diagnostiqués avec un spasme de lôartère coronaire ; 
Á les patients qui ne peuvent pas subir de PAC (pontage aortocoronarien) ; 
Á une occlusion totale ; 
Á les patients qui ne peuvent pas subir dôACTP ; 
Á les patients qui ne conviennent pas aux procédures IVUS. 

 

3.2 Complications 

Les complications suivantes peuvent survenir à la suite dôun examen intravasculaire : 
 

¶ réaction allergique ; 

¶ angor ; 

¶ un arrêt cardiaque ; 

¶ des arythmies cardiaques y compris, mais sans sôy limiter, une tachycardie 
ventriculaire, une fibrillation auriculaire / ventriculaire et un bloc cardiaque complet ; 

¶ une tamponnade cardiaque / un épanchement péricardique ; 

¶ la mort ; 

¶ un dispositif coincé nécessitant une intervention chirurgicale ; 

¶ un embolisme (air, corps étranger, tissus ou thrombus) ; 

¶ une hémorragie / un hématome ; 

¶ hypotension ; 

¶ infection ; 

¶ infarctus du myocarde ; 

¶ ischémie myocardique ; 

¶ un AVC et un accident ischémique transitoire ; 

¶ thrombose non expliquée ; 

¶ une occlusion vasculaire et une fermeture soudaine ; 

¶ un traumatisme vasculaire y compris, mais sans sôy limiter, une dissection et 
une perforation. 
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3.3 Sécurité 

Le Makoto Intravascular Imaging SystemÊ ou MakotoÊ a été conçu pour être utilisé et 

entretenu de la façon la plus sûre possible. Cependant, tout instrument médical peut 

causer des blessures sôil nôest pas correctement installé, utilisé, déplacé ou entretenu ; 

et ce système nôéchappe pas à cette règle.  

Les risques potentiels sont : 

¶ des lésions oculaires (vision) provoquées par une exposition à un rayonnement 
laser direct ou réfléchi ; 

¶ une décharge électrique provoquée par lôentrée en contact avec des 
composants électriques à lôintérieur du système ; 

¶ un préjudice physique provoqué par lôutilisation ou le déplacement du système. 

 

Tout incident grave impliquant le Makoto Intravascular Imaging SystemÊ doit °tre 

signalé immédiatement à Infraredx. Infraredx signalera l'incident, directement ou par 

l'intermédiaire de son représentant local, à l'autorité compétente dans la juridiction de 

laquelle l'incident s'est produit. Les coordonnées d'Infraredx ou de votre prestataire de 

services local figurent dans les sections 1.3 Coordonnées dôInfraredx, ou 13.1 About (À 

propos de)  (À propos de). 

Les informations relatives ¨ la s®curit® et aux performances cliniques du MakotoÊ sont 

disponibles sur demande. 

 

 

Le MakotoÊ est doté de fonctionnalités conçues spécifiquement pour assurer un 

fonctionnement en toute sécurité aux utilisateurs. Tout le personnel du laboratoire de 

cathétérisme doit se familiariser avec lôemplacement et le fonctionnement des 

caractéristiques de sécurité mentionnées ci-dessous. Pendant lôimagerie, les 

composants mobiles sont totalement enfermés. Ainsi, lôutilisateur ne sôexpose pas à des 

risques mécaniques. 

Toute personne utilisant le MakotoÊ pour effectuer une procédure sur un humain de 

quelque nature que ce soit doit comprendre parfaitement les conséquences dôune telle 

utilisation. LôAIUM (American Institute of Ultrasound in Medicine, Institut américain des 

ultrasons en médecine) a publié un document intitulé « Medical Ultrasound Safety » 

(Sécurité des ultrasons en médecine) (AIUM 2009). ALARA est un acronyme désignant 

le principe dôutilisation prudente du diagnostic par ultrasons en obtenant les 

informations diagnostiques à une puissance de sortie As Low As Reasonably 
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Achievable (aussi faible que raisonnablement possible). Pour obtenir une copie de ce 

document, veuillez contacter lôAIUM. 

AVERTISSEMENT 

Les précautions décrites dans cette section doivent être prises 
lors de lôinstallation, du fonctionnement, du déplacement ou de 
lôentretien du système afin dôéviter des situations potentiellement 
dangereuses. 
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SYMBOLE SIGNIFICATION 

 

Avertissement 

 

Attention 

 

Consulter la notice dôutilisation 

 

Consulter le mode dôemploi 

 

Le produit répond aux normes américaines, 

européennes et canadiennes applicables 

telles quôévaluées par TUV Rheinland. 

100-120 V~ 50/60 Hz 5 A 

220-240 V~ 50/60 Hz 3 A 

Le produit fonctionne à partir dôune source 

dôalimentation qui fournit nominalement 

100 VCA, 120 VCA, 220 VCA ou  

240 VCA, 50/60 Hertz  

Le courant maximum est de 5 ampères à 

100-120 VCA, 3 ampères à 220-240 VCA. 

 

Fabricant  

 

Date de fabrication 

 
Numéro de catalogue 
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Numéro de série 

 
Numéro de lot 

 
Date limite dôutilisation 

 

Masse 

 

Représentant autorisé dans la  

Communauté européenne 

 

Mise à la terre de protection (terre) 

 

Application cardiaque directe protégée contre 

les chocs de défibrillation (pièce appliquée  

de type CF) 

 

La quantité contenue dans lôemballage. 

 

Diamètre intérieur du cathéter-guide 

compatible 

 
Diamètre extérieur du fil-guide compatible 
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Ouverture de laser 

 

À conserver à lôabri de la lumière du soleil 

 

Apyrogène 

 

Garder au sec 

 

Limite de température 

 

Limitation dôhumidité 

 

Ce dispositif peut uniquement être vendu ou 

utilisé sur ordonnance dôun médecin 

 

Ne pas utiliser si lôemballage est endommagé 

 

Ne pas réutiliser ce dispositif 
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Ne pas restériliser 

 
Stérilisé à lôoxyde dôéthylène 

 

Nôa pas fait lôobjet dôune évaluation de 

lôinnocuité lorsquôil est utilisé avec une IRM  

 

La marque CE indique que le produit est 

conforme à la législation de l'Union 

européenne ; le numéro indique l'organisme 

notifié spécifique qui effectue l'évaluation de 

la conformité. 

 

Aucune pièce de la console du MakotoÊ ou du contrôleur du MakotoÊ ne peut être 

entretenue par lôutilisateur. Tous les réglages sont effectués en usine avant que le 

produit soit expédié aux clients ou sur site par un membre du personnel ou un 

fournisseur de services dôInfraredx qualifié.  

 

ATTENTION 

Toute modification ou toute tentative de modification du Makoto 
Intravascular Imaging SystemÊ rend la garantie du produit 
nulle et peut également entraîner un dysfonctionnement du 
système.  

Une dégradation du dispositif ou une défaillance du produit peut 
en découler. 

 

 

 

 

 

 



Makoto Intravascular Imaging SystemTM 
Guide dôutilisation 

   
IFU0163rK.fr (2022-04-04)  3-8 

3.4 Précautions optiques 

 

 
AVERTISSEMENT 

Le produit contient un appareil à laser de classe 1M qui émet un 
rayonnement laser invisible. Ne regardez pas directement à 
lôaide dôinstruments optiques. 

 

 
AVERTISSEMENT 

Ne regardez jamais directement dans le faisceau laser 
provenant du système ou réfléchi par une surface. 

 

AVERTISSEMENT 

Ne regardez pas dans le faisceau laser à lôaide de lentilles, de 
jumelles, de loupes, de viseurs de caméra, de télescopes ou de 
tout autre élément ou instrument optique qui pourrait diriger la 
lumière dans lôîil. 

 

AVERTISSEMENT 

Ne permettez jamais à des objets réfléchissants tels que des 
bijoux, des montres, des instruments métalliques ou des miroirs 
dôintercepter et de réfléchir le rayon laser. 

 

Le Makoto Intravascular Imaging SystemÊ intègre un système laser et est classé comme 

un « appareil à laser de classe 1M » en vertu dôune norme sur les performances de 

rayonnement du Department of Health and Human Services (DHHS, Département de la 

Santé et des Services sociaux des États-Unis) conformément à la Radiation Control for 

Health and Safety Act of 1968 (Loi de 1968 sur le contrôle des rayonnements pour la 

santé et la sécurité) et à la CEI 60825-1, Sécurité des appareils à laser. 

Lôénergie lumineuse émise par ce système se situe dans la région invisible et proche 

infrarouge du spectre électromagnétique à des longueurs dôonde comprises entre 1 et 

2 microns. Il est nécessaire de tenir compte de ce fait lorsque des précautions sont 

prises pour éviter une exposition involontaire.  

 

REMARQUE : Le port de lunettes de sécurité laser nôest PAS requis lors de 
lôutilisation du Makoto Intravascular Imaging SystemÊ. 
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3.5 Précautions électriques 

 

AVERTISSEMENT 

Le non-respect des informations contenues dans cette 
section peut entraîner des dommages à lôéquipement, des 
dommages corporels et même la mort. 

 

ATTENTION 

Il est d®conseill® dôutiliser cet ®quipement ¨ proximit® dôautres 
équipements ou empilé sur ceux-ci, sans quoi des 
dysfonctionnements pourraient être rencontrés. Si cette 
configuration est inévitable, suveillez tous les équipements, y 
compris celui-ci, pour vous assurer quôils fonctionnent 
normalement. 

 

ATTENTION 

Les équipements médicaux électriques nécessitent des 
précautions spéciales concernant la compatibilité 
électromagnétique, et doivent être installés suivant les 
informations relatives à la compatibilité électromagnétique 
incluses dans lôAnnexe H : conformité électromagnétique. 

 

 

ATTENTION 

NE positionnez PAS le Makoto Intravascular Imaging SystemÊ 
à proximité dôautres équipements, car cela pourrait provoquer 
des interférences électriques. 

 

ATTENTION 

Une IVUS en direct ou un scan de retrait peut être 
interrompu(e) si le système est exposé à une décharge 
électrostatique (DES). Si une IVUS en direct ou un scan de 
retrait est interrompu(e), le scan peut être immédiatement 
redémarré.  

 

Le Makoto Intravascular Imaging SystemÊ utilise une tension de ligne CA à lôintérieur 

de la console. Le fait de débrancher la fiche du cordon dôalimentation du MakotoÊ de la 

prise coupera lôalimentation du système, provoquant ainsi un arrêt brutal de toutes les 

opérations.  

Aucune pièce du boîtier extérieur ne doit être déplacée, sauf par un technicien qualifié 

et autorisé. 
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Pour réduire le risque dôélectrocution, ne branchez pas le connecteur dôalimentation 

électrique du système à un équipement qui nôest pas protégé à la terre. Ne raccordez 

pas le système à un équipement de classe II. 

Les équipements de communication radiofréquence (RF) peuvent affecter les 

performances du Makoto Intravascular Imaging SystemÊ. Ce type dôéquipement doit 

être situé le plus loin possible du MakotoÊ. Des émissions RF rayonnées ou conduites 

peuvent provoquer une distorsion de lôimage ou dôautres artefacts sur lôécran de lôIVUS. 

 

ATTENTION 

Le système MakotoÊ nôest pas destiné à être utilisé avec un 
équipement chirurgical haute fréquence (HF) / radiofréquence 
(RF). 

 

 

ATTENTION 

Des émissions RF rayonnées ou conduites peuvent provoquer 
une distorsion de lôimage ou dôautres artefacts sur lôécran du 
Makoto Intravascular Imaging SystemÊ. 

 

Infraredx recommande dôutiliser une source dôalimentation sans coupure dans une 

installation dans laquelle des creux de tension ou des interruptions peuvent se produire. 

Le système MakotoÊ est destiné à être branché à lôaide dôun câble réseau à un 

système dôinformation hospitalier protégé et sécurisé. Lorsquôun câble réseau est 

branché au Makoto Intravascular Imaging SystemÊ pour transférer des données vers 

un système dôinformation hospitalier, le câble doit alors être un câble Ethernet blindé 

Cat 5e (consultez la section 3.9). Lôutilisation dôun câble non conforme peut entraîner 

une augmentation des émissions RF ou une diminution de lôimmunité RF.  

 

3.6 Précautions mécaniques 

 

 
AVERTISSEMENT 

Ne positionnez PAS lôopérateur de la console mobile du Makoto 
Intravascular Imaging SystemÊ entre la console du système 
MakotoÊ et dôautres équipements mobiles du laboratoire de 
cathétérisme en raison du risque de dommages corporels.  
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AVERTISSEMENT 

La table dôopération doit être maintenue à niveau pendant 
lôutilisation du système MakotoÊ ou à tout moment lorsque le 
contrôleur du MakotoÊ se trouve dans le champ stérile. 
Nôutilisez PAS les commandes dôinclinaison ou de déplacement 
de la table, si ces dernières sont disponibles. 

 

 
AVERTISSEMENT 

NE positionnez PAS le Makoto Intravascular Imaging SystemÊ 
dans la plage de mouvement des pièces du système de 
radiographie. 

 

 
AVERTISSEMENT 

Assurez-vous que les câbles provenant du Makoto Intravascular 
Imaging SystemÊ ou y étant branchés sont bien à plat sur le 
sol. 

 

Dans un scénario typique dôutilisation, la console mobile du Makoto Intravascular 

Imaging SystemÊ est positionnée près du pied de la table dôexamen ou à droite des 

moniteurs du système de radiographie. Un risque de basculement peut être créé si la 

console mobile du système MakotoÊ entre en contact avec un équipement mobile du 

laboratoire de cathétérisme (table dôexamen, C-Arm, etc.). Ne verrouillez pas les 

roulettes à frein sur la console du MakotoÊ lorsque ce dernier est positionné dans la 

plage de mouvement de lôéquipement en question.  

 

Lors de lôutilisation normale de la console mobile du Makoto Intravascular Imaging 

SystemÊ, différents câbles peuvent être branchés à la console ou en provenir. 

Assurez-vous que les câbles sont bien à plat sur le sol afin de réduire au maximum les 

risques de trébucher. Partout où cela est possible, évitez de poser des câbles dans les 

zones où beaucoup de piétons circulent dans la pièce.  

 

Le contrôleur du MakotoÊ doit être positionné sur une surface plane au cours de la 

procédure, en particulier pendant lôacquisition des données Le contrôleur du MakotoÊ 

doit être positionné dans le support de stockage de la console lorsque la console est 

déplacée ou que le contrôleur nôest pas utilisé. 
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3.7 Précautions chimiques et anti-incendie 

 

 
AVERTISSEMENT 

Cet équipement nôest pas conçu pour être utilisé avec des 
anesthésiques ou des liquides inflammables ou dans des 
environnements riches en oxygène (>25 %). 

 

 

Il nôy a aucun risque chimique ou dôincendie connu associé au Makoto Intravascular 

Imaging SystemÊ.  

 

3.8 Précautions liées au cathéter et aux accessoires 

 

 
AVERTISSEMENT 

 
ÉTAT DE CALIFORNIE (ÉTATS-UNIS UNIQUEMENT) 
 
Les produits jetables compatibles et leur emballage ont été 
stérilisés avec de lôoxyde dôéthylène. Lôemballage peut vous 
exposer à lôoxyde dôéthylène, un produit chimique reconnu par 
lôÉtat de Californie comme cause de cancers, de malformations à 
la naissance ou dôautres problèmes de reproduction. 
 

 

 
AVERTISSEMENT 

 
Les accessoires de cathéter (barrière stérile du contrôleur du 
MakotoÊ, accessoires dôamorçage) sont fournis stériles et sont 
conçus uniquement pour un usage unique. Exclusivement à 
usage unique. Ne pas réutiliser, reconditionner ou restériliser. La 
réutilisation, le retraitement ou la restérilisation peuvent 
compromettre lôintégrité structurelle et entraîner une mauvaise 
qualité dôimage ou causer une blessure, une maladie ou la mort 
du patient. La réutilisation, le retraitement ou la restérilisation 
peuvent également contaminer le dispositif et provoquer une 
infection chez le patient pouvant causer une maladie ou la mort 
du patient. Infraredx ne fait aucune déclaration quant aux 
performances dôun produit réutilisé, retraité ou restérilisé. 
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AVERTISSEMENT 

Nôutilisez PAS le cathéter si lôemballage interne est ouvert ou 
endommagé. 

 

 
AVERTISSEMENT 

Lorsque le cathéter est branché au contrôleur du MakotoÊ, ne 
regardez PAS lôextrémité distale du cathéter ou ne regardez 
PAS directement avec des instruments optiques. 

 

 
AVERTISSEMENT 

Les déchets médicaux peuvent causer une infection et/ou une 
maladie. Après utilisation, jeter le produit et lôemballage 
conformément à la réglementation hospitalière, administrative 
et/ou gouvernementale locale. 

 

 
AVERTISSEMENT 

Des précautions doivent être prises lorsquôun fil-guide est 
exposé dans un vaisseau à stent. Les cathéters qui 
nôencapsulent pas le fil-guide peuvent entrer en contact avec le 
stent à la jonction du cathéter et du fil-guide. 

 

 
AVERTISSEMENT 

 
Des précautions doivent être prises lors de la progression dôun 
fil-guide après le déploiement du stent. Lors du passage dôun 
stent, le fil peut sortir entre des entretoises de stent qui ne sont 
pas complètement apposées. Une progression ultérieure du 
cathéter pourrait emmêler le cathéter et le stent déployé. 
 

 

 
AVERTISSEMENT 

En cas de résistance lors du retrait du cathéter, vérifiez la 
résistance en utilisant la fluoroscopie, puis retirez le système 
entier du cathéter, du cathéter-guide et du fil-guide en utilisant 
un guidage fluoroscopique. 

 

Le Makoto Intravascular Imaging SystemÊ émet un rayonnement laser proche infrarouge 

depuis le laser situé sur la console à travers le contrôleur du MakotoÊ et le cathéter 
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branché. La lumière proche infrarouge est invisible pour lôîil humain. Fixer ou diriger la 

lumière proche infrarouge vers la cornée et la rétine peut causer des lésions oculaires. 

Le Makoto Intravascular Imaging SystemÊ dôInfraredx est conçu pour être utilisé 

uniquement avec le cathéter dôimagerie IVUS+NIRS DualproÊ (RÉF. : TVC-C195-42) 

doté dôExtended BandwidthÊ, un cathéter coronaire jetable à usage unique. 

Avant leur utilisation, examinez soigneusement tous les équipements à utiliser pendant 

la procédure pour vous assurer quôils fonctionnent correctement. Le cathéter a été 

inspecté et stérilisé à lôoxyde dôéthylène avant dôêtre livré. Avant toute utilisation, 

inspectez le cathéter et son emballage pour vous assurer de lôabsence de dommages 

ou de trous sur les emballages stériles. 

 

ATTENTION 

Conservez les cathéters emballés dans un endroit frais et sec. 

 

ATTENTION 

Nôentortillez ou ne courbez pas fortement (>45°) le cathéter à 
aucun moment. Cela peut entraîner une défaillance du câble de 
lecteur.  

 

 

3.9 Respect des normes de sécurité 

 

 
AVERTISSEMENT 

Lôutilisation dôaccessoires non approuvés peut entraîner le non-
respect par le Makoto Intravascular Imaging SystemÊ dôune ou 
plusieurs normes répertoriées dans cette section du manuel. 

 

Le Makoto Intravascular Imaging SystemÊ a été conçu pour respecter toutes les normes 

applicables (CEI, ANSI, ISO, UL, etc.) en matière dôutilisation en toute sécurité de lasers, 

dôultrasons et dôéquipements électriques dans les établissements de santé.  

Les accessoires suivants ont été testés et sont compatibles avec le Makoto 

Intravascular Imaging SystemÊ : câble de données et vidéo intégré (TVC-10PMC), 

câble DVI-D (PN2665), imprimante Bluetooth® (TVC-9BPK) et câble Cat5e blindé 

(PN2690). Contactez votre commercial pour passer commande. 
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Les normes spécifiques incluent notamment : 

Standard Description 

  
CEI 60601-1:2012 version 3.1 Appareils électromédicaux ï Partie 1 : 

exigences générales pour la sécurité et les 
performances essentielles 

ANSI/AAMI ES60601-1:2005/(R)2012 
Canada : CAN/CSA 22,2 N° 60601-1:14 
KS C CEI 60601-1:2008 

  
CEI 60601-1-2:2014 quatrième version Appareils électromédicaux ï Partie 1-2 : 

Exigences générales pour la sécurité de 
base et les performances essentielles - 
Norme collatérale : compatibilité 
électromagnétique - Exigences et tests 

  
CEI 60601-1-6:2010 version 3.0 + A1:2013 Appareils électromédicaux ï Partie 1-6 : 

Exigences générales pour la sécurité de 
base et les performances essentielles ï
Norme collatérale : aptitude à lôutilisation 

CAN/CSA 22,2 N° 60601-1-6:11 

  
CEI 60601-2-37:2007 version 2.0 Appareils électromédicaux ï Partie 2-37 : 

exigences particulières pour la sécurité de 
base et les performances essentielles des 
équipements de diagnostic et de 
surveillance médicaux à ultrasons 

CAN/CSA 22,2 N° 60601-2-37:08 
KS C CEI 60601-2-37:2011 

  
CEI 60825-1:2014 Sécurité des appareils à laser ï Partie 1 : 

exigences et classification des 
équipements 

CFR (Code des règlementations fédérales 
américaines) titre 21 parties 1040.10 et 
1040.11 

  
CEI 62304 : 2006 Logiciels de dispositifs médicaux ï 

Processus de cycle de vie des logiciels CAN/CSA-CEI/IEC 62304:14 
  

ISO 10555-1:2013 Cathéters intravasculaires ï cathéters 
stériles et à usage unique ï Partie 1 : 
exigences générales  

  
ISO 10993 Évaluation biologique des dispositifs 

médicaux 
  

ISO 11135:2014 + A1:2018 Stérilisation des produits médicaux ï 
Oxyde dôéthylène 

  
CEI 62366:2007 (version 1.0) + A1:2014 
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Standard Description 
CAN/CSA-CEI 62366:14 Dispositifs médicaux ï Application de 

lôingénierie de lôaptitude à lôutilisation aux 
dispositifs médicaux 

  
ISO 15223-1:2016 Dispositifs médicaux ï Symboles à utiliser 

avec les étiquettes des dispositifs 
médicaux, lôétiquetage et les informations 
à fournir ï Partie 1 : Exigences générales.  
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4 Description du système 
 

 
AVERTISSEMENT 

Le Makoto Intravascular Imaging SystemÊ est conçu pour être 
exclusivement utilisé par le personnel du laboratoire de 
cathétérisme cardiaque et des médecins qualifiés. 

 
Le Makoto Intravascular Imaging SystemÊ fournit une imagerie intravasculaire basée 
sur un cathéter à lôaide des technologies IVUS et NIRS. Le système utilise à la fois le 
son et la lumière pour caractériser les caractéristiques intravasculaires. 
 

 

Figure 4-1 : console mobile du Makoto Intravascular Imaging SystemÊ équipée du cathéter dôimagerie IVUS+NIRS 

DualproÊ doté dôExtended Bandwidth. 

Contrôleur 

du Makoto 

Console du Makoto (mobile) 

Cathéter dôimagerie 

IVUS+NIRS  

DualproÊ  

(TVC-C195-42)  



Makoto Intravascular Imaging SystemTM 
Guide dôutilisation 

   
IFU0163rK.fr (2022-04-04)  4-2 

Le système comprend trois composants majeurs : 

¶ la console mobile du Makoto Intravascular Imaging SystemÊ ; 

¶ le contrôleur du MakotoÊ ; 

¶ le cathéter dôimagerie IVUS+NIRS DualproÊ doté dôExtended BandwidthÊ 
(consultez les instructions dôutilisation du cathéter). 

 

Le système possède deux composants mineurs : 

¶ la barrière stérile du contrôleur du MakotoÊ (emballée avec le cathéter) ; 

¶ les accessoires dôamorçage du cathéter DualproÊ (comprend des seringues 

dôamorçage, emballées avec le cathéter). 

 

4.1 La console mobile du Makoto Intravascular Imaging SystemÊ 

 

La console mobile du Makoto Intravascular Imaging SystemÊ ou la console du 

MakotoÊ contient de nombreux composants majeurs du système.  

La console du MakotoÊ intègre un module dôalimentation qui fournit lôénergie aux 

différentes parties du système. Le module dôalimentation alimente les écrans, lôunité 

centrale de traitement (CPU), le laser et le contrôleur du MakotoÊ. 

Le CPU est intégré dans la console du MakotoÊ. Le CPU gère, stocke et restitue les 

données enregistrées avec le contrôleur et le cathéter du MakotoÊ. Il contrôle 

également la fonction des interfaces utilisateur graphiques fournies à lôutilisateur. Le 

système contient un lecteur de données capable de stocker environ 1 000 scans. Les 

données peuvent être exportées du système sur des disques optiques (disque DVD ou 

Blu-Ray), une clé USB ou un emplacement réseau via un câble Ethernet. 

Le système peut être configuré pour envoyer des données aux réseaux PACS. 

ATTENTION 

Il nôest PAS recommandé dôutiliser le Makoto Intravascular 
Imaging SystemÊ comme un lieu dôarchivage permanent des 
données. Les données de scans doivent être archivées sur 
dôautres supports et supprimées du disque dur du système. 

 

La source de lumière laser pour la réalisation de NIRS est intégrée dans la console. La 

lumière est fournie par un câble à fibre optique au contrôleur MakotoÊ où le cathéter 

est branché pendant lôutilisation. Côest ce faisceau de lumière qui permet au système de 

générer un chemogram ou une carte de probabilité des plaques dôintérêt contenant un 

cîur lipidique. 
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Figure 4-2 : Makoto Intravascular Imaging SystemÊ (TVC-MC10). 

La console intègre deux écrans. Le premier, celui du médecin, est orienté vers 

lôopérateur stérile pendant lôutilisation. Le second écran tactile, celui du poste de travail 

du technicien, est orienté vers le technicien non stérile ou lôopérateur circulant pendant 

lôutilisation. Cette disposition permet à lôopérateur non stérile dôannoter des données 

tout en fournissant à lôopérateur stérile une vue dégagée sur lôécran. 

Lôécran du médecin est un moniteur FHD 1080p de 21,5 pouces (1920x1080p). 

Lôinclinaison et le pivotement de lôécran peuvent être ajustés pour fournir un angle de 

vision optimal au médecin stérile. 

Lôécran du poste de travail du technicien est un moniteur tactile capacitif FHD 1080p de 

15,6 pouces (1920x1080p). La rotation, lôinclinaison et le pivotement de lôécran peuvent 

être ajustés pour permettre un angle de travail confortable. 

 

 

 

Écran du poste 
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Écran du 

médecin 

 Roulettes à 

frein de 

direction 
 Roulettes à 

frein de 

position 
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Figure 4-3 : panneau dôinterface du côté gauche du Makoto Intravascular Imaging SystemÊ (TVC-MC10) intégrant les 

ports USB 3.0 et le lecteur de supports optiques Blu-Ray. 

 

 

Figure 4-4 : panneau dôinterface du côté droit du Makoto Intravascular Imaging SystemÊ (TVC-MC10) intégrant le bouton 

dôalimentation et les ports de sortie vidéo, PACS et dôintégration de la radiographie. 

La console du MakotoÊ est également configurée pour exporter un signal vidéo 

couleur de 1920x1080p (au format 16:9) à lôaide dôun câble vidéo DVI-D blindé. La 

résolution vidéo exportée peut être configurée en option sur 1600x1200 (au format 4:3). 

En plus de lôécran du poste de travail du technicien, les utilisateurs peuvent interagir 

avec le système en utilisant la souris fournie. Cette souris est située sous lôécran du 

poste de travail du technicien.  

Le système est équipé de deux roulettes à frein directionnelles pour faciliter le transport 

et de deux roulettes à frein supplémentaires pour maintenir en place ou entreposer 

le système.  
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4.2 Interface utilisateur graphique du Makoto Intravascular Imaging 

SystemÊ 

Les fonctions du Makoto Intravascular Imaging SystemÊ sont commandées grâce aux 

interfaces utilisateurs graphiques du logiciel : le mode Acquisition et le mode Révision. 

 
 

 

Figure 4-5 : mode Acquisition.  

 

Figure 4-6 : mode Révision. 

 

4.2.1 Mode Acquisition 

Le mode Acquisition est un mode de fonctionnement dans lequel de nouvelles données 

peuvent être enregistrées par le Makoto Intravascular Imaging SystemÊ. Il se compose 

de quatre phases différentes : « Setup » (Configuration), « Prime » (Amorçage), 

« Scan » (Numérisation) et « Close » (Fermeture). En utilisant la barre de progression, 

lôopérateur peut se déplacer facilement et rapidement entre les phases pour sôadapter 

au rythme de la procédure.  

 

Basculement 

entre les modes 
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Figure 4-7 : affichage du mode Acquisition en mettant lôaccent sur la commande de la barre de progression de la 
procédure pour changer de phases et la commande de basculement du mode du Makoto pour changer de modes de 
fonctionnement. La phase « Scan » (Numérisation) du mode Acquisition est active et le basculement du mode du Makoto 
vers le mode Révision est désactivé dans lôimage. 

La barre de progression décrit les différentes étapes ou phases de lôacquisition des 

données et fournit également une commande pour changer de phases. Touchez les 

différents noms de phase pour passer à la phase désirée. 

 

REMARQUE : Les phases du mode Acquisition peuvent se dérouler dans 
nôimporte quel ordre. Chaque étape peut être ignorée puis 
reprise si cela est nécessaire ou plus pratique. 

 

Touchez la commande de basculement du mode du Makoto, lôicône « Review » 

(Révision) , pour accéder au mode de fonctionnement Révision. Cette action ne 

peut être réalisée que si aucune procédure active nôest en cours. Toute procédure 

active doit être fermée avant de changer de modes. 

 

4.2.1.1 La phase « Setup » (Configuration)  

La phase « Setup » (Configuration) permet à lôopérateur de saisir des informations sur le 

patient et la procédure pour faciliter lôarchivage et la récupération ultérieure pour révision. 

 

Barre de 

progression 

Basculement entre 
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Makoto 
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ATTENTION 

Des précautions doivent être prises lors de la saisie des 
informations sur le patient pour en assurer lôexactitude. 

 

 

Figure 4-8 : phase « Setup » (Configuration) du mode Acquisition. 

 

REMARQUE : Les données de scans peuvent être enregistrées avant la fin 
de la phase « Setup » (Configuration). 

 

Les informations sur la procédure et le patient peuvent être configurées manuellement 

ou en sélectionnant les données déjà présentes dans le système ou la liste de travail 

des modalités. Lôutilisation des fonctions dôachèvement semi-automatiques peut réduire 

les erreurs de transcription et améliorer lôexactitude des informations saisies. 

REMARQUE : Lôutilisation des fonctions dôachèvement semi-automatiques 
peut réduire les erreurs de transcription et améliorer 
lôexactitude des informations saisies. 

 

REMARQUE : La phase « Setup » (Configuration) nôest pas accessible 
pendant la numérisation active. 

 

Consultez la section 7 pour obtenir des informations plus détaillées sur la configuration 
de la procédure. 
Consultez la section 13.3 pour plus dôinformations sur la configuration des connexions 

de la Liste de travail de modalité. 
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4.2.1.2 . La phase « Prime » (Amorçage) 

 

 
AVERTISSEMENT 

Le cathéter stérile doit être amorcé conformément au document 
contenant les instructions dôutilisation inclus dans lôemballage du 
cathéter. 

 

 
AVERTISSEMENT 

Le suivi des conseils dôamorçage supplémentaires à lôécran ne 
remplace pas la formation à lôutilisation du Makoto Intravascular 
Imaging SystemÊ. 

 

La phase « Prime » (Amorçage) donne des conseils à lôopérateur sur le processus 

dôamorçage dôun cathéter et le branchement du cathéter sur le contrôleur du MakotoÊ. 

 

Figure 4-9 : phase « Prime » (Amorçage) du mode Acquisition. 

 

REMARQUE : Appuyez sur le bouton « Mark » (Marque) sur le contrôleur du 

MakotoÊ, , pour passer à la prochaine phase. 
 

REMARQUE : La phase « Prime » (Amorçage) nôest pas accessible pendant 
la numérisation active.  

 

Consultez la section 8 pour obtenir plus dôinformations sur le branchement du cathéter et 

les instructions dôutilisation fournies avec le cathéter pour plus de détails sur lôamorçage. 
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4.2.1.3 La phase « Scan » (Numérisation)  

La phase « Scan » (Numérisation) de la procédure permet à lôopérateur dôenregistrer 

des données de scans IVUS et NIRS pendant la procédure en cours. Lôopérateur peut 

également relire, réviser, supprimer, mesurer, annoter et modifier la vitesse du prochain 

retrait pendant la procédure en cours lorsque lôimagerie active nôa pas déjà commencé.  

Cette phase inclut de nombreux affichages de données dôimagerie complexes, y 

compris le chemogram, le chemogram au niveau du bloc, le halo du chemogram, les 

images IVUS transversales et longitudinales. 

Les deux ensembles dôinformations, NIRS et IVUS, enregistrés par le Makoto 

Intravascular Imaging SystemÊ sont coenregistrés et peuvent être révisés en utilisant 

la lecture synchronisée. 

 

  

Figure 4-10 : phase « Scan » (Numérisation) du mode Acquisition avec les affichages principaux des informations sur 
lôimage indiqués. 

 
La phase « Scan » (Numérisation) permet également dôaccéder aux fonctions dôannotation 

et de mesure disponibles pendant une procédure active. Les scans peuvent être 

renommés, annotés et avoir des cadres individuels marqués pour être facilement 

récupérés en vue de leur révision. Des mesures du cadre peuvent également être prises.  
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Figure 4-11 : phase « Scan » (Numérisation) du mode Acquisition avec les commandes de base indiquées. 

 

Consultez les sections 9 et 10 pour obtenir des informations plus détaillées sur 

lôacquisition, la navigation et la mesure de scans. 

 

4.2.1.4 La phase « Close » (Fermeture)  

La phase « Close » (Fermeture) de la procédure permet à lôopérateur dôexaminer un 

résumé des données obtenues pendant une procédure avant lôarchivage sur le système. 

Il est important de terminer la phase « Close » (Fermeture) pour chaque procédure 

avant de mettre le système hors tension. 

 

Figure 4-12 : phase « Close » (Fermeture) du mode Acquisition. 
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REMARQUE : Commencer une nouvelle acquisition à partir du contrôleur du 
MakotoÊ fera automatiquement retourner le mode Acquisition 
à la phase « Scan » (Numérisation). 

 

REMARQUE : Vous devez entrer les informations minimales requises du 
patient et de la proc®dure sur lô®cran de la phase ç Setup è 
(Configuration) pour terminer la phase « Close » (Fermeture). 

 

REMARQUE : Les proc®dures qui nôont pas ®t® ferm®es avant l'arrêt du 
système sont accessibles depuis le mode Révision. La 
proc®dure peut °tre reprise avant dô°tre ferm®e et archiv®e. 

 

Consultez la section 11 pour obtenir des informations plus détaillées sur la fermeture de 

la procédure. 

 

4.2.2 Mode Révision 

Le mode Révision se compose de deux phases : la phase « Select » (Sélection) et la 

phase « View » (Visualisation). Ces phases permettront à lôutilisateur de sélectionner 

une procédure, puis de la visualiser ou de lôexporter pour la visionner plus tard.  

 

 

 

Figure 4-13 : mode Révision avec la barre de progression et les commandes de basculement du mode du Makoto 
mises en évidence. 

Touchez la commande de basculement du mode du Makoto, lôicône Scan , pour 

accéder au mode de fonctionnement Acquisition. Cela peut être fait à nôimporte quel 

moment dans la phase « Select » (Sélection) du mode Révision.  

Barre de 

progression 
Basculement entre les 

modes du Makoto 
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4.2.2.1 La phase « Select » (Sélection) 

La phase « Select » (Sélection) permet à lôopérateur de rechercher et de choisir des 

procédures précédemment enregistrées pour la visualisation, la modification, la 

suppression, lôimpression ou lôarchivage sur dôautres supports. 
 

  

Figure 4-14 : phase « Select » (Sélection) du mode Révision. 

Pendant cette phase, les données correctement formatées peuvent être sélectionnées 

à partir dôautres supports à importer dans le Makoto Intravascular Imaging SystemÊ. 

Consultez la section 12 pour obtenir des informations plus détaillées sur les fonctions 

de sélection, dôexportation et dôimportation. 

 

4.2.2.2 La phase « View » (Visualisation)  

La phase « View » (Visualisation) fournit de nombreuses commandes similaires à celles 

trouvées pendant la phase « Scan » (Numérisation) du mode Acquisition. Dans cette 

phase, les données peuvent être révisées, analysées, annotées et supprimées en 

utilisant des commandes habituelles telles que décrites dans la section 10. 
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Figure 4-15 : phase « View » (Visualisation) du mode Révision. 

 

REMARQUE : Les données dôune seule procédure peuvent être consultées  
à la fois. 

 

Touchez la commande de basculement du mode du Makoto , lôicône « Review » 

(Révision) , pour revenir à la phase « Select » (Sélection) du mode Révision.  

 

4.3 Le contrôleur du MakotoÊ 

Le contrôleur du MakotoÊ (voir ci-dessous) désigne lôinterface entre le cathéter et la 

console du MakotoÊ. La poignée du cathéter est insérée dans une douille sur la face 

avant du contrôleur, puis tournée pour terminer les branchements physiques, optiques 

et électriques. Ces branchements permettent à lôunité dôactionner simultanément le 

noyau dôimagerie interne et de stabiliser la gaine externe du cathéter. Le mode de 

retrait du contrôleur du MakotoÊ permet une rotation automatique à environ 

1 800 tr/min et un mouvement longitudinal distal à proximal à une vitesse de 0,5, 1,0, et 

2,0 mm/s. Le noyau dôimagerie du cathéter peut effectuer un retrait automatique continu 

dans la direction distale à proximale sur une longueur totale de 150 mm. 
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4.3.1  Indicateurs 

 

  

Figure 4-16 : contrôleur du MakotoÊ. 

Le contrôleur du MakotoÊ est équipé dôun écran LCD qui fournira des messages sur le 

statut et des graphiques à lôutilisateur. 

 

 

 

 

Figure 4-17 : les indicateurs de lôécran LCD du contrôleur du MakotoÊ pendant lôacquisition dôIVUS en direct en position 

« READY » (PRÊT) (en haut) et pendant lôacquisition de retrait automatique (en bas). 

Le contrôleur identifie pour lôutilisateur deux positions importantes pour lôopération : la 
position « READY » (PRÊT) et la position « 0,0 mm ». 
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« READY » Cette position est la position la plus distale que la douille du  
(PRÊT) cathéter du contrôleur du MakotoÊ peut atteindre. Cette position 

indique lôemplacement où le contrôleur est prêt à ce que 
lôutilisateur « LOAD » (CHARGE ou branche) ou décharge 
(débranche) correctement un cathéter ou commence lôimagerie. Il 
sôagit également de la position dans laquelle la fenêtre de 
transmission du cathéter branché est la plus résistante à la torsion 
liée à la poussée et est prête à être suivie sur un fil-guide. 

 

Figure 4-18 : quand le contrôleur du MakotoÊ est en position « READY » (PRÊT), lôicône « READY » (PRÊT) sôaffiche à 

droite de lôécran de la console du MakotoÊ. 

« 0,0 mm » Cette position est lôemplacement de départ de lôimagerie 

ininterrompue continue pendant un scan IVUS en direct transféré. 

La position « 0,0 mm » est dôenviron 5 mm proximale à la position 

« READY » (PRÊT). Les images IVUS transversales ne peuvent 

pas être visionnées ou enregistrées dans les emplacements situés 

entre « READY » (PRÊT) et « 0,0 mm ».  

Comme indiqué dans la Figure 4-17, lôécran LCD du contrôleur du MakotoÊ est utilisé 

pour communiquer dôimportantes informations sur les capteurs, les modes de 

fonctionnement et les statuts : 

Type de cathéter Ce symbole apparaît pour indiquer quôun cathéter IVUS + 

NIRS a été branché sur le contrôleur. 

Mode Acquisition Cet indicateur affiche « LIVE » (DIRECT), « AUTO » ou rien 

pour indiquer le mode dôacquisition dôimages actuel du 

système. 

Vitesse de Cet indicateur communique la vitesse actuelle de transfert  

mouvement  quand lôacquisition dôimages est en cours. Quand aucune 

acquisition dôimages nôest en cours, la vitesse de mouvement 

communique le paramètre de commande de la vitesse du 

prochain retrait (consultez la section 9.2.1). 

« READY » Quand lôécran affiche « READY » (PRÊT), cela indique que  

Icône de la position 

« READY » (PRÊT). 
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(PRÊT) le système est en position « READY » (PRÊT) ou dans la 

position la plus distale que lôutilisateur peut atteindre en faisant 

fonctionner le contrôleur du MakotoÊ. 

Échelle relative La plage dôacquisition dôimages continue, de 0,0 à 150,0 mm, 

est indiquée sur le contrôleur avec des démarcations à 

50,0 mm et à 100,0 mm.  

Position relative Quand le contrôleur du MakotoÊ est déplacé de manière 

proximale à partir de la position « READY » (PRÊT), 

lôemplacement actuel de la pointe dôimagerie est représenté 

par une ligne verticale sur lôéchelle relative. 

  

 

 

Figure 4-19 : indicateur de la position relative pendant aucune imagerie (en haut), une IVUS en direct (au milieu) et un 
retrait (en bas). 

  

Position/Distance En imagerie Live IVUS ou Pullback, la distance affichée 

d®signe la distance entre le d®but de lôimagerie et la marque 

la plus r®cente en millim¯tres. Lorsque le dispositif nôest pas 

en mode dôimagerie, la position actuelle de la pointe 

dôimagerie appara´t. 

Enregistrement Lôindicateur dôenregistrement apparaît lorsque le système 

enregistre les images affichées sur lôopérateur. 

Plage enregistrée La plage dôenregistrement de lôIVUS en direct actuel ou de 

lôacquisition de retrait automatique est repr®sent®e par un 

rectangle plein. Les translations des acquisitions IVUS en 

direct apparaissent en blanc et les acquisitions de retrait 

automatiques apparaissent en vert, la partie pleine indiquant 

la plage enregistrée depuis la dernière marque. 
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Figure 4-20 : Plage enregistr®e pendant lôacquisition en cours : IVUS en direct avec position actuelle identique ¨ la 

position de départ (1re ligne), IVUS en direct enregistrée avec position actuelle proximale à la dernière pression du bouton 
« Mark » (Marque) (2e ligne), retrait automatique sans marque (3e ligne), retrait automatique avec barre pleine indiquant la 

plage enregistrée depuis la dernière marque (4e ligne). 

« LOAD » Ce message indique que le contrôleur du MakotoÊ est en  

(CHARGER) position « READY » (PRÊT) et quôun cathéter peut être chargé 

dans la douille. 

 

Figure 4-21 : lôécran LCD du contrôleur du MakotoÊ indiquant le statut « LOAD » (CHARGER). 

« TURN » Ce message indique que le contrôleur du MakotoÊ a détecté  

(TOURNER) un mauvais branchement de la poignée du cathéter. 

  

Figure 4-22 : lôécran LCD du contrôleur du MakotoÊ indiquant une instruction de tourner la poignée du cathéter. 

« WAIT » Le contrôleur du MakotoÊ attend que la console du MakotoÊ  
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(ATTENDRE) et lôinterface utilisateur du logiciel soient initialisées. 

 

Figure 4-23 : lôécran LCD du contrôleur du MakotoÊ indiquant dôattendre que le système termine de démarrer par le statut 

« WAIT » (ATTENDRE). 

 

 
AVERTISSEMEN

T 

Des situations dangereuses, y compris des blessures au patient 

ou à l'opérateur, peuvent se produire si les avertissements 

affichés sont ignorés. 

 
« SEE DISPLAY »   

(VOIR LôÉCRAN) Le contr¹leur MakotoÊ a d®tect® une erreur ou une 

d®faillance. Ce message invite lôop®rateur ¨ consulter les 

®crans du Makoto Intravascular Imaging SystemÊ pour 

obtenir des instructions plus détaillées. 

  

Figure 4-24 : Message dôerreur (gauche) et message de d®faut interne (droite) du contr¹leur MakotoÊ. Dans les deux cas, 
l'utilisateur est invit® ¨ consulter l'®cran du syst¯me pour corriger lôerreur ou le d®faut. 

 
 

Remarque : Si le message « See Display » (Voir lôécran) apparaît à plusieurs reprises 
après avoir suivi les indications à lôécran, contactez votre fournisseur de 
services local ou le service clientèle Infraredx pour obtenir de lôaide.  
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Si le MakotoÊ Imaging System surveille les interactions du système pendant les 

périodes d'inactivité. Si la limite de temps d'inactivité et les conditions sont respectées, 

le contrôleur entrera en mode économie d'énergie. Le système n'entrera pas en mode 

économie d'énergie si une procédure est en cours ou si un cathéter est connecté au 

système. La connexion de l'utilisateur fait sortir le système du mode économie 

d'énergie. 

 

REMARQUE : Les utilisateurs disposant de droits d'administrateur peuvent régler 

le temps d'inactivité, voir la section 13.8 Système.  

 

 

4.3.2 Commande du mode Acquisition 

 

 
AVERTISSEMEN

T 

Des situations dangereuses, y compris des blessures au patient 

ou à l'opérateur, peuvent se produire si les avertissements 

affichés sont ignorés. 

 

 
AVERTISSEMEN

T 

Le mouvement linéaire du contrôleur s'arrête lorsqu'une force 

excessive est rencontrée. 

Vérifiez que le cathéter ne présente pas de pliures, de coudes 

aigus ou de dommages et résolvez-les avant de continuer. 

Appuyez sur « STOP » (ARRÊT), , sur le contrôleur 

MakotoÊ et suivez les instructions ¨ l'®cran pour r®soudre le 

problème. 
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Nôutilisez PAS les fonctions de translation à une étape pour 

r®gler le probl¯me dôentortillement ou de d®formation. La gaine 

du cathéter pourrait être endommagée ou le patient blessé. 

 

 
AVERTISSEMEN

T 

Si une pression du bouton « STOP » (ARRÊT), , sur la 
commande MakotoÊ nôinterrompt pas le mouvement du 
cathéter, débranchez immédiatement le Makoto Intravascular 
Imaging SystemÊ. 
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Figure 4-25 : boutons des fonctions du contrôleur du MakotoÊ, deux modèles disponibles (ci-dessus et ci-dessous)). 

 

Le contrôleur du MakotoÊ est équipé de boutons simples permettant à lôutilisateur de 
commander le mouvement du système et lôacquisition de données. 
 

Retour en position 
« READY » (PRÊT) Ce bouton d®placera automatiquement le noyau dôimagerie 

du cathéter depuis son emplacement actuel vers la position 
« READY » (PRÊT) la plus distale. Cette position du noyau 
est nécessaire avant de déplacer le cathéter dans le patient 
ou de le brancher ou débrancher. 

« STOP » (ARRÊT) Ce bouton arrête le mouvement du contrôleur du MakotoÊ 
et toute collecte de données en cours. 

Retrait Ce bouton déclenche la rotation automatique et le retrait 
automatique dôun cathéter branché. La vitesse de rotation 
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est réglée à environ 1 800 tr/min, mais la vitesse de retrait 
correspond à la vitesse sélectionnée sur la console du 
MakotoÊ (0,5, 1,0, ou 2,0 mm/sec).  

 À partir de « READY » (PRÊT) : une pression et un 
relâchement du bouton de retrait déplacent le noyau dôimagerie 
à la position « 0,0 mm » et démarrent lôIVUS en direct pour 
pouvoir visionner un aperçu de lôemplacement dôimagerie de 
départ du scan. Appuyez à nouveau sur le bouton de retrait 
pour lancer le scan. Maintenir enfoncé le bouton de retrait en 
position « READY » (PRÊT) permet dôignorer lôaperçu et de 
commencer le mouvement et lôenregistrement automatiques. 
Le bouton peut être relâché lorsque lôécran indique que 
lôimagerie « AUTO » a commencé. 

 À partir de la position Ò0,0 mm : une pression et un 

relâchement du bouton de retrait déclenchent un 

mouvement immédiat et lôenregistrement du scan.  

Vous pouvez appuyer sur le bouton de retrait, , 

pendant que le contrôleur du MakotoÊ est immobile ou quôil 

tourne pendant une acquisition dôIVUS en direct. 

 

Enregistrement / Enfoncer une fois ce bouton permet de déclencher la  

IVUS en direct  rotation automatique du noyau dôimagerie du cathéter (sans 

retrait). Une image IVUS transversale en direct apparaît sur 

lôécran de la console du MakotoÊ. 

Enfoncer plusieurs fois le bouton dôIVUS en direct, , 

permet dôactiver ou de désactiver un enregistrement de 

lôacquisition IVUS en direct en cours. Cette action nôarrête 

pas la rotation du noyau dôimagerie du cathéter.  

 

« Mark » (Marque) Ce bouton met en signet un cadre ou une position dans un 

scan pour une référence ou une révision ultérieures.  

 Pendant lôacquisition dôimages, ce bouton remet lôaffichage 

du contrôleur à zéro. La distance affichée par la commande 

sera mesur®e ¨ partir de lôendroit de la derni¯re pression sur 

le bouton « Mark » (Marque). 
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 Pendant lôIVUS en direct non enregistrée, ce bouton 

enregistre un seul cadre IVUS. 

 Pendant la phase « Prime » (Amorçage) du mode 

Acquisition, ce bouton fait passer le système à la phase 

« Scan » (Numérisation). 

Distal rapide Maintenir enfoncé ce bouton déplace le noyau dôimagerie du 

cathéter de manière distale à une vitesse de 10 mm/s. 

Appuyer sur ce bouton et le relâcher déplace le noyau 

dôimagerie du cath®ter de mani¯re distale dôune distance 

fixe de 0,5 mm.  

Distal lent Maintenir enfoncé ce bouton déplace le noyau dôimagerie du 

cathéter de manière distale à une vitesse de 2 mm/s. 

Appuyer sur ce bouton et le relâcher déplace le noyau 

dôimagerie du cath®ter de mani¯re distale dôune distance 

fixe de 0,1 mm. 

Proximal lent Maintenir enfoncé ce bouton déplace le noyau dôimagerie du 

cathéter de manière proximale à une vitesse de 2 mm/s. 

Appuyer sur ce bouton et le relâcher déplace le noyau 

dôimagerie du cath®ter de mani¯re distale dôune distance fixe 

de 0,1 mm. 

Proximal rapide Maintenir enfoncé ce bouton déplace le noyau dôimagerie du 

cathéter de manière proximale à une vitesse de 10 mm/s. 

Appuyer sur ce bouton et le relâcher déplace le noyau 

dôimagerie du cath®ter de mani¯re distale dôune distance fixe 

de 0,5 mm. 

REMARQUE : Les fonctions du contrôleur « Return to READY » (Retour à PRÊT), 

« Live IVUS » (IVUS en direct) et « Pullback » (Retrait) sont accessibles 

à partir de la console Makoto en activant les fonctions de commande à 

distance, voir la section 13.8.7 Activer le contrôle à distance.  

 

4.4 Cathéters dôimagerie compatibles 

Les cathéters dôimagerie compatibles sont emballés séparément et sont stérilisés pour un 

usage unique. Veuillez consulter les instructions dôutilisation fournies avec le cathéter 

pour obtenir plus dôinformations sur le cathéter ainsi que sa préparation et son utilisation. 
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4.5 Spectroscopie par proche infrarouge (NIRS) 

Le Makoto Intravascular Imaging SystemÊ est conçu pour identifier les plaques 

dôint®r°t contenant un cîur lipidique par le sang dans les artères coronaires dôun cîur 

qui bat par lôintermédiaire dôun cathéter coronaire de numérisation. Le système utilise la 

spectroscopie par proche infrarouge (NIRS) pour identifier la composition chimique de 

la paroi artérielle comme aide au cardiologue interventionnel dans lôévaluation des 

plaques coronaires. La base fondamentale de cette capacité dôimagerie est le principe 

de la spectroscopie de réflectance diffuse, qui est bien établi et utilisé dans de 

nombreuses disciplines scientifiques.  

En résumé, la lumière NIR incidente est diffusée et absorbée par le tissu et la lumière 

réfléchie contient des informations sur la composition du tissu en fonction de ses 

propriétés dôabsorption et de diffusion. Ces propriétés dôabsorption et de diffusion sont 

régies par la composition chimique et la morphologie du tissu. 

 

4.5.1 Chemogram 

Après un retrait du noyau dôimagerie du cathéter par lôartère, le logiciel du système 

affiche une représentation graphique, sous la forme dôune carte, indiquant la probabilité 

quôune plaque dôint®r°t contenant un cîur lipidique (PCL) soit pr®sente. Cette carte est 

appelée chemogram. Il fournit une image de lôartère qui indique la probabilité de trouver 

une plaque dôint®r°t contenant un cîur lipidique ¨ un endroit particulier du scan. Une 

forte probabilité est affichée en jaune et la probabilité décroissante passe 

progressivement au rouge. 

 

4.5.2 Lecture de lôécran du chemogram 

Pendant lôacquisition de données en temps réel, la carte de détection du fil-guide 

identifie lôemplacement de lôartefact produit par un fil-guide numérisé et aide le médecin 

à identifier les artefacts dôimages dans les données spectroscopiques. À la fin dôun scan 

de retrait, le moniteur du Makoto Intravascular Imaging SystemÊ affiche deux cartes de 

pseudo-couleur de la paroi artérielle. Ces cartes sont le chemogram et le chemogram 

au niveau du bloc. Le chemogram et le chemogram au niveau du bloc indiquent les 

zones de lôartère coronaire étant susceptibles de contenir des plaques dôintérêt 

contenant un cîur lipidique.  

Les vues longitudinales de lôécran représentent le scan de droite à gauche (distal à 

proximal). Lôaxe x indique que la distance de retrait en millimètres de lôextrémité distale 

de la fenêtre de transmission du cathéter. Lôaxe y dans le chemogram et la carte de 
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détection du fil-guide correspondent à la position angulaire relative des caractéristiques 

de la paroi vasculaire en degrés (la position angulaire de départ par rapport à la paroi 

est arbitraire). La partie du scan située à lôintérieur du cathéter-guide peut être indiquée 

en gris uni sur les extrémités proximales du chemogram et du chemogram au niveau du 

bloc, si le système détecte que le scan a été inséré dans le cathéter-guide.  

Le chemogram est coloré dans une échelle de couleur allant de rouge à jaune, dôune 

faible probabilité à une forte probabilité de présence de lipides. La couleur jaune 

apparaît à lôutilisateur lorsque la probabilité de présence de lipides dépasse 0,6 

nôimporte où sur lôécran. Un masque semi-transparent noir apparaît sur le chemogram 

dans les zones où lôalgorithme de détection de PCL a déterminé lôexistence dôun faible 

signal ou dôune autre interférence. 

Le moniteur du système affiche les résultats de lôindice de masse du cîur lipidique 

(LCBI) à gauche du chemogram. Le LCBI est un rapport entre les scores de probabilité 

des lipides positifs (>0,6) et les scores de probabilité de lipides valides totaux dans la 

plage sélectionnée du chemogram, sur une échelle de 0 à 1 000 (masse du cîur 

lipidique faible à élevée) dans un segment défini. Dans des études (consultez la 

section 17.2 de lôannexe B) portant sur des échantillons dôautopsie déterminés 

histologiquement, il a été démontré quôil existait une corrélation entre le LCBI et la 

présence et le volume de fibroathérome dans lôartère. 

  

Figure 4-26 : le LCBI régional et maximal pour la région sélectionnée sôaffichent à gauche dans le chemogram. 

Le logiciel affichera le LCBI maximal dôune fenêtre de longueur fixe (4 mm par défaut) 

dans un segment et indiquera la position dans la région.  

 

LCBI Lipid Core Burden Index (Indice de masse du cîur lipidique) 

calculé pour chaque retrait et dans des régions définies par 

lôutilisateur. 

LCBI 

LCBI max 

Emplacement 

du LCBI max. 

Région 

sélectionnée 

pour le LCBI 
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LCBI max. Lipid Core Burden Index calculé sur une largeur spécifiée 

dans un retrait total ou une région numérisée spécifiée par 

lôutilisateur. La valeur maximale trouvée sera présentée à 

lôutilisateur. 

Le chemogram du niveau du bloc, qui améliore le chemogram, est affiché au centre de 

la vue IVUS (écographie intravasculaire) longitudinale et se trouve sans dimension dans 

la direction y. Le bloc chemogram associé au support affiché actuellement apparaîtra 

au centre de la vue IVUS transversale. Le chemogram du niveau du bloc est divisé en 

deux grands blocs de 2 mm et résume lôensemble des résultats prédictifs valables dans 

le segment correspondant du chemogram. Le chemogram du niveau du bloc est 

représenté par 4 couleurs allant de la probabilité la plus forte à la plus faible : jaune, 

brun, orange et rouge. Si le nombre de pixels dans le bloc du chemogram affecté par 

une interférence ou un signal faible dépasse 25 %, alors la couleur du bloc est noire. 

 

REMARQUE :  Si le pourcentage de spectres trop faibles pour contribuer à la 

génération du chemogram dépasse 12 %, aucun chemogram ne sera 

généré. 
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4.6 Ultrason intravasculaire 

Le Makoto Intravascular Imaging SystemÊ est conçu pour identifier la paroi de la 

lumière et de la cuve, à travers le sang, dans les artères coronaires dôun cîur en 

battement par cathétérisme et coronarographie. Le système utilise des ultrasons pour 

analyser les limites de la paroi de la lumière et de la cuve de lôartère et aide le 

cardiologue chargé de lôintervention à évaluer les plaques dôathérome. Les ultrasons 

peuvent identifier dôautres particularités de lôartère comme des stents implantés et 

dôautres particularités des plaques dôathérome comme la calcification.  

Cette information est analysée par lôenvoi dôimpulsions sonores à la paroi de la cuve 

depuis lôextrémité de lôimagerie du cathéter et la réception de lôécho. Les 

caractéristiques morphologiques de lôartère absorbent et renvoient le son différemment. 

Ces signaux sôaffichent ensuite à lôécran pour lôinterprétation. 

Avec des images dôangiographie, les analyses de la progression de la lésion peuvent 

être réalisées en comparant deux diamètres dans la zone dôintérêt. Généralement, ces 

diamètres sont sélectionnés depuis un emplacement de référence et lôemplacement 

avec le plus petit diamètre de lumière dans la zone ciblée. La réduction de ce diamètre 

est désignée par une sténose. Lôutilisation de lôangiographie pour analyser les 

diamètres dôune projection unique peut sôavérer difficile au moment dôanalyser les 

emplacements des lésions ou de la cible avec des lumières excentriques. LôIVUS 

permet de mieux analyser la lumière, y compris les lumières excentriques.  

Comparer la zone de lumière peut également offrir un moyen supplémentaire dôanalyser 

la progression dôune lésion. Le Makoto Intravascular Imaging SystemÊ comparera 

deux zones à des emplacements différents pour fournir la lumière de la zone de 

sténose (AS). 

 

AS% =  (Zonemax ï Zonemin) / Zonemax 

 

 



Makoto Intravascular Imaging SystemTM 
Guide dôutilisation 

   
IFU0163rK.fr (2022-04-04)  5-1 

5 Stockage, déplacement et positionnement du 

Makoto Intravascular Imaging SystemÊ 
 

5.1 Déplacement du Makoto Intravascular Imaging SystemÊ 

Le Makoto Intravascular Imaging SystemÊ est équipé de deux roulettes verrouillables à 

lôarrière du système et deux roulettes verrouillables directionnelles à lôavant du système. 

  

Figure 5-1 : Makoto Intravascular Imaging SystemÊ. 

  

Débloquez les verrous de toutes les roulettes pour déplacer les manettes des roulettes 

vers le haut pour d®placer, tourner ou manîuvrer le syst¯me dans des espaces réduits. 

 

Remarque : Bloquez les roulettes à verrou directionnel à lôavant du 
système pour faciliter le transit sur des distances plus 
longues. 

 

Roulettes à 

frein de 

position 

 

 Roulettes à 

frein de 

direction 
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Remarque : Pendant le transit, positionnez les moniteurs en ligne 
avec la base du Makoto Intravascular Imaging SystemÊ 
pour augmenter la visibilité. 

5.2 Positionnement pour utilisation 

 

 
AVERTISSEMENT 

NE positionnez PAS lôopérateur de la console mobile de Makoto 
Intravascular Imaging SystemÊ entre le système et un autre 
équipement en mouvement dans le laboratoire de cathétérisme.  

 

 
AVERTISSEMENT 

NE positionnez PAS le Makoto Intravascular Imaging SystemÊ 
avec les verrous de roulette bloqués dans lôamplitude normale 
de mouvement de pièces du système de radiographie ou 
dôautres équipements du laboratoire de cathétérisme pendant 
son utilisation. 

 

Le Makoto Intravascular Imaging SystemÊ est positionné pour utilisation à proximité du 

pied de la table dôopération ou à lôautre bout de la table dôopération par le médecin, à 

droite du système dôopération de radiographie. 

Une fois la position souhaitée du système obtenue, engagez les roulettes verrouillables 

de position sur le système. 

 

ATTENTION 

NE repositionnez PAS le Makoto Intravascular Imaging 
SystemÊ de manière à entraver lôaccès à la prise électrique. 

 

Remarque : Réglez la position dôaffichage du médecin sur le Makoto 
Intravascular Imaging SystemÊ pour optimiser la visibilité de 
lôimage pendant son utilisation. 

 

 

Remarque : Pour éviter tout mouvement accidentel de la console MakotoÊ, 
engagez les roulettes verrouillables de position à lôarrière de 
la console. 
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5.3 Stockage avant utilisation 

 

ATTENTION 

Ces instructions NE sont PAS pour un stockage à long terme 
du Makoto Intravascular Imaging SystemÊ. Veuillez contacter 
le service client dôInfraredx ou votre fournisseur de service local 
pour être guidé sur la manière de préparer le système pour un 
stockage à long terme. 

 

Lorsquôil nôest pas en fonctionnement, le Makoto Intravascular Imaging SystemÊ doit 

être configuré afin de réduire le risque dôendommagement du système.  

1. Positionnez le contrôleur MakotoÊ fermement dans le 

support à lôarrière du système. 

2. Enroulez le cordon du contrôleur MakotoÊ soigneusement 

et accrochez le crochet supérieur au panneau arrière 

du système. 

3. Enroulez le cordon dôalimentation soigneusement et 

accrochez le crochet inférieur à lôarrière du système. 

4. Engagez les roulettes verrouillables à lôarrière du système. 

5. Tournez les moniteurs pour les aligner avec la base du 

système. 

En plus des étapes précédentes, sélectionnez un emplacement de stockage facile 

dôaccès situé dans une zone de faible trafic où le risque dôimpact avec dôautres 

équipements en mouvement (lits, brancards...) est réduit. Lôemplacement doit répondre 

aux exigences environnementales et physiques définies dans la section 16 de ce manuel. 
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6 Démarrage du Makoto Intravascular Imaging 

System 

6.1 Alimentation On  

 

 
AVERTISSEMENT 

Assurez-vous que les câbles provenant du Makoto Intravascular 
Imaging SystemÊ ou y étant branchés sont bien à plat sur le 
sol. 

 
 

1. Retirez le cordon dôalimentation à lôarrière du système. Laissez le reste du 
cordon tomber à plat sur le sol tout en tenant la prise. 
 

2. Branchez le système à une prise de terre accessible facilement. 

 

Figure 6-1 : panneau latéral et bouton dôalimentation Makoto Intravascular Imaging SystemÊ sélectionnés. 

3. Allumez le système en appuyant et en relâchant le bouton situé sur le côté de la 
console. Cette action alimentera la console du système MakotoÊ et du 
contrôleur MakotoÊ. 

 

Une fois le système allumé et le logiciel chargé, la phase de configuration du mode 

dôacquisition Makoto sera présentée à lôopérateur. 

 

Bouton 
dôalimentation 
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ATTENTION 

 
Si la prise du câble dôalimentation appropriée à la région 
dôutilisation nôest pas équipée dôune mise à la terre, alors 
raccordez un câble de mise à la terre au goujon de terre 
équipotentiel situé à lôarrière du Makoto Intravascular Imaging 
SystemÊ dans la partie inférieure. 
 
 

 
Figure 6-2 : goujon de mise à la terre équipotentiel 
situé à lôarrière du Makoto Intravascular Imaging 

SystemÊ à lôextrémité droite de la partie inférieure. 

 
 

ATTENTION 

Pendant le démarrage, la prise de connexion du cathéter du 
contrôleur MakotoÊ pivotera automatiquement. Si un cathéter 
est raccordé pendant le démarrage du système, assurez-vous 
que le cathéter a été retiré du patient 

 

Remarque : Si le Makoto Intravascular Imaging SystemÊ est allumé et nôest 
pas en position « READY » (PRÊT), lorsque le système lôexige, 
veuillez utiliser les contrôles de mouvement distal pour faire 
avancer lôimagerie distale jusquôà ce que vous atteigniez la 
position « READY » (PRÊT). 
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6.2 Alimentation Off  

 

 
AVERTISSEMENT 

Si à tout moment, le bouton « STOP » (ARRÊT), , situé sur 
le contrôleur du MakotoÊ nôarrête pas le mouvement du 
cathéter, débranchez immédiatement le Makoto Intravascular 
Imaging SystemÊ. 

 

Pour éteindre le Makoto Intravascular Imaging SystemÊ, appuyez et relâchez le 
bouton dôalimentation situé sur le côté droit de la console. 

 

ATTENTION 

Si une br¯ve pression du bouton dôalimentation nô®teint pas le 
système, laissez le bouton dôalimentation enfonc® (~5 
secondes) jusquô¨ ce que le syst¯me sôarr°te. 

 

 

6.3 Connexion de lôutilisateur 

 
Le MakotoÊ Imaging System peut °tre configur® pour prendre en charge diff®rents 
profils d'utilisateurs afin de contrôler l'accessibilité de certaines fonctionnalités, de 
certains paramètres ou de certaines données patient. 
 
Consultez la section 13.10 Gestion des utilisateurs 

Cette section est accessible aux utilisateurs disposant de droits d'Administrateur. Cette 

section des paramètres permet de gérer les listes d'utilisateurs, de modifier les 

autorisations des utilisateurs, de définir ou de modifier les mots de passe ou de 

r®pliquer les profils d'utilisateurs sur d'autres Makoto Integrated Imaging SystemsÊ. 

 pour plus d'informations sur les profils d'utilisateurs, les autorisations et les 

restrictions. 
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Figure 6-3. £cran de connexion de l'utilisateur du MakotoÊ Imaging System 

6.3.1 Connexion standard 

Lorsque le système est allumé, une combinaison valide de nom d'utilisateur et de 
mot de passe sera demandée pour enregistrer l'accès au système et définir les 
autorisations appropriées et l'accès aux données enregistrées sur le système.  

 

6.3.2 Saut ou connexion anonyme 

Dans certains cas d'intervention urgente ou si les utilisateurs ont oublié leurs 
identifiants Makoto, il est toujours possible de faire fonctionner le système et 
d'obtenir des données. Lorsqu'un utilisateur s'est connecté au Makoto Imaging 
System sans utiliser un nom d'utilisateur ou un mot de passe valide, les 
caractéristiques et les fonctions du système sont limitées à celles qui sont 
essentielles pour effectuer une procédure. 

6.3.3 Activation du clavier virtuel 

Dans certaines situations ou configurations du Makoto Imaging System, il peut être 

préférable de désactiver le clavier virtuel à l'écran. Touchez l'icône du clavier pour 

activer ou désactiver le clavier. La désactivation du clavier peut limiter certaines 

fonctions d'annotation et de recherche qui nécessitent une saisie au clavier si aucun 

clavier physique n'est connecté. 
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6.4 Déconnexion de l'utilisateur  

 
Le MakotoÊ Imaging System offre la possibilit® aux utilisateurs de se d®connecter 
de la séance en cours sans éteindre le système. 
 
L'utilisateur peut se déconnecter du système en touchant ou en cliquant sur l'icône 
« Options », puis en sélectionnant « Log Out Username » (Déconnexion de 
l'utilisateur). 
 
Si le système reste inactif au-delà de la limite de temps configurée sans cathéter, le 

système se déconnecte automatiquement s'il n'y a pas de procédure en cours ou de 

cathéter connecté. 
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7 Configuration des informations du patient et de 

la procédure 
Dans le mode dôacquisition pendant la phase de configuration, lôutilisateur peur entrer 

des informations sur le patient et la procédure afin dôarchiver et de faciliter la 

récupération dans le cadre dôune révision ultérieure. Ces informations peuvent être 

insérées au début de la procédure ou à chaque fois avant la fin de la procédure. 

 

 

Figure 7-1 : phase de configuration du mode dôacquisition dans les contrôles principaux sélectionnés. 

Quatre ®l®ments dôidentification du patient peuvent °tre entr®s pour chaque proc®dure. 

Il sôagit du nom du patient, de son num®ro dôidentification, de son genre et de sa date 

de naissance. Les champs de données configurés comme « requis » doivent être 

compl®t®s pour fermer la proc®dure afin de lôexaminer ou de lôarchiver par la suite. 

 Nom du patient Le nom du patient peut être inséré dans le format 

suivant : nom, prénom, et initiale du deuxième prénom. 

 Identification du patient Le numéro médical enregistré ou le numéro de fichier 

du patient. 

 Genre Le Makoto Intravascular Imaging SystemÊ propose 

trois options de genre différentes pour aider à décrire 

le patient. 

 Date de naissance Le jour, mois et année du patient peuvent être 

spécifiés. 

Paramètres 

« Clear » 

(Effacer) 

Continuer 

 LCBI 

Source de liste 

de patients 

prévus 
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Remarque : Utilisez lôoption de genre « Autre » pour lôentrée de patients 
anonymes. 

 

Quatre autres champs peuvent être utilisés pour identifier plus en détail la procédure :  

 Identification de procédure Le numéro ou code utilisé pour identifier cette 

procédure. 

 Identification dôadhésion Il sôagit dôune valeur dôidentification de la procédure 

souvent assignée au moment de lôenregistrement du 

patient pour la procédure et qui peut être utilisée par 

le PACS (système dôarchivage et de transmission 

dôimages) afin de vérifier les données transférées. 

Cette valeur est généralement insérée 

automatiquement lorsque les paramètres de liste de 

travail de modalité sont utilisés. 

 Médecin Le nom du médecin chargé de la procédure. 

 Groupe de cathéter Le numéro de groupe construit du cathéter utilisé 

pendant cette procédure dôimagerie.  

 

ATTENTION 

Assurez-vous de lôinsertion correcte des informations du patient 
pour éviter un mauvais étiquetage des données ou une perte 
des données de la procédure. 

 

REMARQUE : Les champs requis pour lôidentification du patient et de la 
procédure peuvent être configurés dans les paramètres, voir 
section 13. 

 

Remarque : Insérez le numéro de groupe du cathéter pour acquérir des 
données pour insérer automatiquement le numéro de groupe du 
cathéter dans chaque fichier numérisé lorsquôil est enregistré. 
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7.1 Insertion manuelle des informations du patient et de la procédure 

Lôinsertion manuelle des informations du patient et de la procédure peut être effectuée 
avec le clavier du logiciel à lôécran.  

Appuyez sur « Clear » (Effacer)  pour supprimer les données du patient et de la 

procédure dans les champs de configuration puis recommencez. 

 

Remarque : Les champs dôinformation peuvent être complétés avant de 
fermer la procédure lorsque le système nôest pas en train 
dôacquérir activement des données dôimage. 

 

7.2 Insertion semi-automatique des informations du patient et de la 

procédure 

Les données du patient peuvent être directement insérées dans les champs 

fournis tels que décrits ci-dessus. Pour améliorer la cohérence de lôinsertion pour 

les patients revenus ou prévus, il est possible de sélectionner les informations 

dans le répertoire local ou la liste des patients programmés (liste de travail). 

Remarque : Appuyez sur les titres de colonne dans la liste de patients 
prévus pour réduire la liste de différentes manières. 

 

Remarque : Tapez le texte dans le filtre pour réduire la liste aux noms et 
identifications du patient allant avec votre insertion. Effacez le 
texte ou appuyez sur effacer pour revenir à la liste complète. 

 

Remarque : La liste des patients locaux apparaît par défaut. Lôoption 
« Worklist » apparaît lorsque le système est configuré sur 
connexion de la liste de travail de modalité. 

 

Remarque : Faire un choix dans la liste effacera les données 
correspondantes dans les champs Patient et Procédure. 

 

7.2.1 Listing des patients locaux 

Le système chargera automatiquement les informations du patient des procédures 

enregistrées précédemment du système dans le listing des patients prévus.  
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Cliquez sur le nom souhaité dans la liste pour compléter la configuration du nom 

du patient, de lôidentification du patient, du genre et de la date de naissance.  

Les champs de la dernière procédure nécessiteront une insertion manuelle. 

 

Figure 7-2 : phase de configuration avec contrôle de sélection pour la source du listing des patients prévus sélectionnée. 

 

7.2.2 Liste de travail de modalité 

Si le système a été configuré pour charger les informations de la liste de travail de 

modalité du système dôinformation de lôhôpital (HIS), alors le contenu du listing 

des patients prévus peut être remplacé par un listing des patients locaux dans la 

liste de travail de modalité récupérée dans le HIS. 

Consultez la section 13 pour configurer les paramètres de connexion de la liste de 

travail de modalité. 

Le système récupèrera automatiquement tous les détails du patient et de la 

procédure pour lôangiographie, « XA », le type de modalité pour la date 

dôaujourdôhui et le rend disponible pour la sélection sur le système. 

Cliquez sur le nom souhaité dans la liste pour compléter la configuration du nom 

du patient, de lôidentification du patient, du genre et de la date de naissance et les 

informations de procédures rendues disponibles par le HIS, tout comme 

lôidentification dôadhésion.  

Les champs de procédure restants devront être saisis manuellement. 

 

Remarque : Pour actualiser les saisies de la liste de travail de modalité 

affichées, alternez entre les options « Local », , 

et « Worklist » (Liste de travail) . 
 

 

Source de liste de 

patients prévus 
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7.3 Effacer les informations du patient et de la procédure 

Pour effacer les informations du patient et de la procédure et recommencer, cliquez sur 

« Clear » (Effacer) . 

Cette action nôeffacera pas les données numérisées de la procédure active. 

 

7.4 Passage à la phase suivante  

Après avoir inséré les données du patient et de la procédure, pour aller à la phase 

« Prime » (Amorçage) du mode Acquisition, cliquez sur « Continue » (Continuer) 

. 

 

Remarque : Utilisez le contrôle de progression pour modifier les phases ; 
appuyez sur la phase de votre choix pour passer les phases de 
la procédure. 

 

Remarque : Avec un cathéter connecté, en pressant le bouton « Live IVUS » 

(IVUS en direct), , le contrôleur MakotoÊ avancera 
immédiatement à la phase « Prime » (Amorçage). 

 

Remarque : Avec un cathéter connecté, en pressant le bouton « Pullback » 

(Retrait), , le contrôleur MakotoÊ avancera 
immédiatement à la phase « Scan ». 



Makoto Intravascular Imaging SystemTM 
Guide dôutilisation 

   
IFU0163rK.fr (2022-04-04)  8-1 

8 Amorce du cathéter et préparation du contrôleur 

MakotoÊ pour utilisation  
 

La phase suivante de la procédure commence avec lôamorce du cathéter. En parallèle, 

le contrôleur MakotoÊ peut être placé dans le champ stérile pour utilisation. La 

préparation de lôimagerie sôachève avec la connexion du cathéter au contrôleur et en 

évaluant la préparation du cathéter. 

8.1 Amorce du cathéter 

 

 
AVERTISSEMENT 

Le cathéter stérile doit être amorcé et préparé conformément au 
document contenant les instructions dôutilisation inclus dans 
lôemballage du cathéter. 

 

  
Figure 8-1 : le guidage dôamorce à lôécran proposé dans la phase « Prime » (Amorçage) du mode Acquisition. 

 

Le Makoto Intravascular Imaging SystemÊ proposera un guidage à lôécran dans les 

étapes principales pour amorcer un cathéter raccordé au contrôleur MakotoÊ. 

 

Ces étapes sont prévues pour illustrer et augmenter les instructions fournies avec le 

cathéter. Cela ne remplace pas la nécessité pour lôutilisateur dôêtre formé, et de lire et 

de comprendre les instructions dôutilisation fournies avec le cathéter. 

À lôaide des illustrations à lôécran, des illustrations fournies avec le cathéter et des 

instructions écrites dôutilisation du cathéter, lôopérateur stérile doit amorcer le cathéter. 
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8.2 Préparation du contrôleur MakotoÊ 

Le contrôleur MakotoÊ doit être placé dans une barrière stérile du contrôleur MakotoÊ 

avant dôêtre placé sur la table dôopération.  

Veuillez remarquer que les instructions suivantes nécessitent la participation dôun 

opérateur stérile et non stérile pour appliquer la barrière stérile et placer le contrôleur 

MakotoÊ dans le champ dôopération : 

 

 
AVERTISSEMENT 

Si la barrière stérile du contrôleur MakotoÊ est endommagée, 
remplacez-la par une nouvelle barrière stérile. 

 

 
AVERTISSEMENT 

Gardez la main de lôopérateur en dehors du couvercle bleu de la 
barrière stérile.  

 

 
AVERTISSEMENT 

 
Positionnez le contrôleur MakotoÊ sur un emplacement stable 
de la table dôopération. NE placez PAS le contrôleur à proximité 
des bords de la table. 
 

 

 
AVERTISSEMENT 

La table dôopération doit être maintenue à niveau pendant 
lôutilisation du système Makoto Ê ou à tout moment lorsque le 
contrôleur du système MakotoÊ se trouve dans le champ 
stérile. Nôutilisez PAS les commandes dôinclinaison ou de 
déplacement de la table, si ces dernières sont disponibles. 

 

 
AVERTISSEMENT 

Assurez-vous que le cordon détendu est fourni dans le champ 
stérile pour sôadapter aux mouvements de la table, de la console 
ou du patient pour réduire les risques de mouvements 
inattendus du contrôleur MakotoÊ. 
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AVERTISSEMENT 

Les articles stériles NE doivent PAS être en contact avec le 
contrôleur MakotoÊ jusquôà lôouverture de la prise du cathéter 
de la barrière stérile du contrôleur MakotoÊ. 

 

 
AVERTISSEMENT 

Ne permettez pas au côté du couvercle du joint de la barrière 
stérile qui a été en contact avec la prise du contrôleur MakotoÊ 
dôêtre en contact avec lôopérateur stérile. 

 

Pour positionner le contrôleur MakotoÊ dans le champ stérile, effectuez les étapes 

suivantes : 

 

1. Lôopérateur non stérile retire la barrière stérile de la boîte du cathéter. 
 

2. Lôopérateur non stérile ouvre le package contenant la barrière stérile du 
contrôleur MakotoÊ. 
 

3. Lôopérateur stérile retire la barrière stérile du contrôleur MakotoÊ de son 
emballage, et déplie les deux petits plis de la barrière qui cachent le joint blanc et 
le couvercle en plastique bleu. 
 

4. Lôopérateur non stérile retire le contrôleur MakotoÊ du support sur la console, 
qui est à lôextérieur du champ stérile. 
 

5. Lôopérateur non stérile maintient le contrôleur MakotoÊ parallèle au sol dans les 
airs à proximité du champ stérile tout en tenant la poignée à lôarrière du 
contrôleur. 
 

6. Lôopérateur stérile insère sa main droite dans le pli de la barrière stérile du 
contrôleur MakotoÊ indiqué par une main et une flèche. La barrière doit être 
orientée de manière à ce que le couvercle bleu de la prise soit aligné avec la 
partie supérieure du contrôleur MakotoÊ. 
 

7. La main gauche est insérée dans le pli de lôautre côté de la barrière stérile du 
contrôleur MakotoÊ également indiqué par une main et une flèche. 
 

8. Lôopérateur stérile maintient la barrière stérile du contrôleur MakotoÊ ouverte. 
 

9. Lôopérateur non stérile envoie le contrôleur MakotoÊ à lôopérateur stérile en 
plaçant le contrôleur dans la barrière stérile du contrôleur MakotoÊ ouverte. 
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10. Lôopérateur stérile saisit le contrôleur MakotoÊ jusquôà la barrière stérile du 

contrôleur MakotoÊ par les poignées sur le dessus du contrôleur, supportant 
tout son poids. 
 

11. Lôopérateur non stérile relâche ensuite le contrôleur puis tient les bords de 
lôouverture de la barrière stérile du contrôleur MakotoÊ indiqués par des flèches 
et tire la barrière pour couvrir le câble ombilical du contrôleur MakotoÊ. 
 

12. Lôopérateur stérile place le contrôleur MakotoÊ fermé sur la table dôopération. 
 

13. Lôopérateur stérile aligne le joint blanc de la barrière stérile du contrôleur 
MakotoÊ avec la prise du contrôleur MakotoÊ et raccorde le joint de la barrière 
à la prise.  
 

14. Lôopérateur non stérile doit raccorder la position du cordon pour éviter que la 
partie ensachée sorte de la zone de procédure stérile pendant lôutilisation. 
 
 
Le contrôleur MakotoÊ est désormais prêt pour la connexion du cathéter. 
 

ATTENTION 

Assurez-vous que le joint blanc est fermement raccordé à la 
prise du contrôleur MakotoÊ. Le matériel de la barrière ne doit 
pas gêner lôouverture. Si cela est appliqué correctement, il doit y 
avoir un espace entre le joint blanc et la surface avant du 
contrôleur. 
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8.3 Connexion du cathéter 

 

 
AVERTISSEMENT 

Le cathéter stérile doit être manipulé et préparé conformément 
au document contenant les instructions dôutilisation inclus dans 
lôemballage du cathéter. 

 

 
AVERTISSEMENT 

Ne touchez pas le dessous du couvercle bleu car il pourrait avoir 
été en contact avec la prise du contrôleur MakotoÊ qui nôest 
pas stérile. 

 

Les instructions du cathéter fournies dans ce manuel sont uniquement pour les 

directives générales. Suivez toujours les instructions pour lôutilisation de la 

documentation fournie avec chaque cathéter Infraredx. 

Le cathéter doit être connecté au contrôleur MakotoÊ par un opérateur stérile. 

 

ATTENTION 

Le contrôleur MakotoÊ doit être positionné sur la table du 
patient de manière à ce quôil y ait un espace suffisant pour que 
la connexion du cathéter soit disponible et que la prise du 
cathéter du contrôleur MakotoÊ ne soit pas entravée. 

 

ATTENTION 

Ne contaminez pas les faces en fibre du cathéter ou du 
contrôleur MakotoÊ pendant la connexion. 

 

1. Confirmez que le joint blanc de la barrière du contrôleur MakotoÊ stérile est 
raccordé à la prise du contrôleur MakotoÊ. 
 

2. Retirez le couvercle bleu de la barrière du contrôleur MakotoÊ stérile le long des 
lignes perforées et placez-le hors du champ stérile. 
 

3. Confirmez que le contrôleur MakotoÊ est en position PRÊT comme indiqué par le 
message « LOAD » sur lôécran LCD situé sur la partie supérieure du contrôleur. 
 

4. Alignez la poignée du cathéter avec le côté coloré vers le haut.  
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5. Insérez la poignée du cathéter dans la prise du cathéter du contrôleur MakotoÊ. 
 

6. Tournez la poignée du cathéter dans le sens des aiguilles dôune montre jusquôà 
ce que lôécran LCD du contrôleur indique que le cathéter est correctement 
connecté en observant le message « READY » (PRÊT).  
 

 
Remarque : Si le contrôleur MakotoÊ localise une connexion partielle du 

cathéter, alors les instructions seront indiquées sur lôécran LCD 
ou « Voir lôécran » sera indiqué sur lôécran LCD du contrôleur et 
des indications supplémentaires détaillées sôafficheront sur 
lôécran du système MakotoÊ. 

 

8.4 Test du cathéter 

Après lôamorce du cathéter comme indiqué dans les instructions fournies avec le 

cathéter et la connexion du cathéter au contrôleur MakotoÊ, la performance du 

cathéter peut être vérifiée avec la fonction « Live IVUS » dans le système.  

Amorcez le cathéter avec une solution saline de 0,5 mL supplémentaire puis appuyez 

sur « Live IVUS » (IVUS en direct), , dans le contrôleur MakotoÊ pour démarrer 

lôimagerie. Si une image IVUS apparaît sous forme de cercles concentriques et que la 

clarté de lôimage est satisfaisante, alors appuyez sur « STOP » (ARRÊT), , sur 

lôécran ou appuyez sur « STOP » (ARRÊT), , dans le contrôleur MakotoÊ. 

 

Remarque : Si la qualité de lôimage nôest pas satisfaisante ou est sombre, 
continuez de rincer le cathéter avec la seringue dôamorçage. 

 

Procédez à la phase de numérisation en appuyant sur « Scan », , dans le 

contrôle de progression en haut de lôécran.  

 

Remarque : Lôanalyse de la qualité du cathéter principal peut être effectuée 
sur les écrans de phase « Prime » (Amorçage) ou « Scan ». 
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Remarque : Pendant la rotation du cathéter et la mise à jour de lôimage, 

appuyez sur le bouton « Mark » (Marque), , du contrôleur 
MakotoÊ pour passer à la phase de numérisation. 

 

Remarque : 

Appuyez sur le bouton « Pullback » (Retrait), , de lôécran 
du contrôleur MakotoÊ pour passer le système à la phase de 
numérisation et démarrer une acquisition de retrait automatique.  
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9 Acquisition des images numérisées 

intravasculaires MakotoÊ 
 

 
AVERTISSEMENT 

Consultez les instructions dôutilisation du cathéter pour le 
guidage du chargement du cathéter sur le fil-guide, le cathéter 
dans le cathéter de guidage et le passage du cathéter dans 
lôartère. 

 
Après lôanalyse de la qualité du cathéter principal, le cathéter doit être positionné sur le 

fil-guide et passé comme indiqué dans les instructions dôutilisation du cathéter. 

Il y a deux types dôacquisitions de données pouvant être réalisées avec le Makoto 

Intravascular Imaging SystemÊ : Acquisition du Live IVUS et du retrait automatique.  

Lôacquisition du Live IVUS génèrera des images IVUS sans chemogram. Un retrait 

automatique génèrera des images IVUS avec un chemogram. 

 

9.1 Acquisition du Live IVUS 

Durant lôacquisition de données Live IVUS, le système démarrera la rotation de 

lôimagerie du cathéter sans démarrer le retrait automatique (translation proximale) 

de lôimagerie. Une image IVUS transversale apparaîtra à lôécran et sera mise à jour 

pendant lôactivation du Live IVUS.  

 

Figure 9-1 : Mode Acquisition du Makoto pendant un balayage IVUS en direct non enregistré, avec les fonctions de 
contrôle à distance activées 

« Mark » 

(Marque) 

Enregistrement 

Arrêt 

Vitesse de 

translation 

actuelle 

Position 

PRÊT 

Retrait 
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Remarque : Un scan Live IVUS ne sera pas sauvegardé dans la mémoire du 
système sauf si lôutilisateur décide de lôenregistrer. 

 
Remarque : Live IVUS produira seulement une image IVUS ; aucune donnée 

NIRS ne sôaffichera ou ne sera générée sur le chemogram. 

 
Remarque : Live IVUS produira une image IVUS transversale en direct. 

Lôimage IVUS appara´tra ®galement sur lô®cran de lôIVUS 
longitudinale pendant un scan Live IVUS enregistré. 

 

9.1.1 Démarrage du Live IVUS 

Appuyez sur le bouton Live IVUS, , du contrôleur MakotoÊ pour activer 
lôimagerie IVUS en temps réel. Le statut du mode imagerie sur lôécran LCD sera 
mis à jour pour afficher « LIVE » et les informations dôemplacement sont 
imprimées avec un texte blanc. 

 

  

Figure 9-2 : le contrôleur MakotoÊ affiche lôacquisition Live IVUS non enregistrée à la position PRÊT (gauche) et à la 

position 0,0 mm (droite). 

REMARQUE : Si les fonctions de contrôle à distance sont activées, 

l'imagerie IVUS en direct peut être lancée en touchant l'icône 

« Live IVUS » (IVUS en direct), , sur le moniteur. Voir la 

section 13.8.7 Activer le contrôle à distance pour activer les 

fonctions. 
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9.1.2 Translation du Live IVUS 

 

WARNING 

Des situations dangereuses, y compris des blessures au patient 

ou à l'opérateur, peuvent se produire si les avertissements 

affichés sont ignorés. 

 

WARNING 

Le mouvement linéaire du contrôleur s'arrête lorsqu'une force 

excessive est rencontrée. 

Vérifiez que le cathéter ne présente pas de pliures, de coudes 

aigus ou de dommages et résolvez-les avant de continuer. 

Appuyez sur « STOP » (ARRÊT), , sur le contrôleur 

MakotoÊ et suivez les instructions à l'écran pour résoudre le 

problème. 

 

Nôutilisez PAS les fonctions de translation ¨ une ®tape pour 

r®gler le probl¯me dôentortillement ou de d®formation. La gaine 

du cathéter pourrait être endommagée ou le patient blessé. 

 
 

 

 

 

 

Figure 9-3 : commandes de base de translation de lôimagerie, diff®rentes configurations (dessus, dessous) peuvent 
exister. 

Proximal lent 

Proximal rapide 
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Lorsque vous effectuez un scan Live IVUS, utilisez les commandes de 

mouvement distal et proximal du contrôleur MakotoÊ pour régler lôemplacement 

de lôimage en cours dans lôartère. 

Une pression prolongée sur les commandes de mouvement lent effectuera une 

translation dans la direction souhaitée à une vitesse de 2,0 mm/s. Une pression 

rapide effectuera une translation dans la direction souhait®e dôune distance fixe 

de 0,1 mm. 

Une pression prolongée sur les commandes de mouvement rapide effectuera 

une translation dans la direction souhaitée à une vitesse de 10,0 mm/s. Une 

pression rapide effectuera une translation dans la direction souhait®e dôune 

distance fixe de 0,5 mm. 

 

Remarque : Pendant lôimagerie active en position PRÊT, la translation dans 
la direction proximale résultera en un déplacement de la position 
de lôimage dans la gamme dôimagerie continue de 0 mm à 150 
mm. 

Le retour à la position PRÊT peut se produire uniquement 
lorsque le système nôacquiert pas dôimage. 

 

Remarque : Pendant que vous procédez activement à lôimagerie, la 
translation proximale ET distale se produira uniquement dans 
une gamme de 0 mm à 150 mm. La translation sôarrêtera 
automatiquement lorsque les emplacements extrêmes sont 
atteints et lôimagerie poursuivra. 

 

Remarque : Pendant quôà la position 0 mm et aucune imagerie, en appuyant 

sur les commandes de lôemplacement distal,  ou 

, replacera le contrôleur et lôimagerie du cathéter en 
position PRÊT. 

 

9.1.3 Enregistrement dôune image Live IVUS 

Pendant que vous effectuez un scan Live IVUS non enregistré, une image simple 

peut être sauvegardée pour alimenter la procédure. Cette image peut être 

sauvegardée, vérifiée, mesurée, ou supprimée. 
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Lors dôun scan Live IVUS, appuyez sur le bouton « Mark » (Marque) du contrôleur 

MakotoÊ, , ou appuyez sur la commande « Mark » (Marque), , de lôécran 

du système MakotoÊ pour ajouter un signet à lôimage. Cette image sera enregistrée 

comme un scan dôimage simple.  

 

9.1.4 Enregistrement dôun scan Live IVUS 

Un ensemble dôimages de Live IVUS peut être enregistré en un seul fichier numérisé.  
 

  

Figure 9-4 : mode dôacquisition Makoto pendant un scan Live IVUS enregistré. 

Appuyez sur le bouton Live IVUS du contrôleur MakotoÊ, , ou appuyez sur 

« Record » (Enregistrer) , sur lôécran du système MakotoÊ à proximité de 
lôimage IVUS transversale pour activer lôenregistrement. 

Appuyez sur le bouton Live IVUS du contrôleur MakotoÊ, , ou appuyez sur 

Enregistrer, , toujours sur lôécran du système MakotoÊ pour arrêter 
lôenregistrement de données uniquement. Le cathéter poursuivra sa rotation et 
lôimage IVUS transversale poursuivra sa mise à jour.  
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Figure 9-5 : £cran LCD du contr¹leur MakotoÊ pendant le processus de transition du d®but du Live IVUS non 
enregistr® sur READY (PRąT) (gauche) ¨ lôenregistrement, puis de la translation proximale et stationnaire du Live 
IVUS (milieu) à la remise à zéro, et à la translation proximale pendant lôenregistrement (droite). Remarquez lôapparition 
de lôic¹ne dôenregistrement pendant le Live IVUS enregistr®. Lorsque la translation est effectu®e pendant le Live IVUS 
enregistr® une barre pleine appara´t o½ lôenregistrement dans cette acquisition a déjà été effectué depuis la dernière 
marque (milieu et droite), tandis que lôenregistrement pr®alable ¨ la derni¯re marque est une barre vide (droite). 

Pendant la translation du Live IVUS, lôemplacement relatif, réel, et les indicateurs de 

vitesse de la translation seront mis à jour. 

Remarque : Appuyez sur le bouton « STOP » (ARRÊT) du contrôleur 

MakotoÊ,  ou encore appuyez sur « STOP » (ARRÊT) 

 sur lôécran du système MakotoÊ pour arrêter la rotation et 
le mouvement du cathéter ET terminer lôenregistrement.  

 

Remarque : Appuyez sur le bouton « Pullback » (Retrait) du contrôleur 

MakotoÊ, , pour terminer lôenregistrement du Live IVUS en 
cours et démarrer un nouveau scan de retrait automatique dans 
la configuration du taux de retrait en cours. Les scans de retrait 
automatique sont toujours enregistrés. 

 

Remarque : Des marques peuvent être placées dans le fichier numérisé et 
des mesures IVUS transversales peuvent être réalisées dans les 
images dôun scan Live IVUS enregistré pour mieux alimenter la 
procédure. 

 

9.1.5 Marquer et remettre à zéro en Live IVUS 

Pendant lôacquisition Live IVUS enregistr®e, des marques peuvent °tre plac®es et 

consultées grâce au bouton « Mark è (Marque) du contr¹leur ou ¨ lôic¹ne ç Mark » 

(Marque) ¨ lô®cran. 
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Pendant lôacquisition Live IVUS non enregistr®e, des marques peuvent °tre plac®es et 

consultées en enregistrement image par image grâce au bouton « Mark » (Marque) du 

contrôleur ou ¨ lôic¹ne ç Mark è (Marque) ¨ lô®cran. 

Ajouter une marque pendant lôacquisition Live IVUS r®initialisera lôaffichage de la 

distance parcourue à 0,0 mm. 

 

9.1.6 Arrêt du Live IVUS 

Un scan Live IVUS peut être supprimé de deux manières :  

a. Appuyez sur le bouton STOP, , du contrôleur MakotoÊ ou appuyez 

sur STOP, , sur lôinterface utilisateur pour arrêter les mouvements du 
contrôleur MakotoÊ, interrompre les mises à jour de lôimage IVUS 
transversale, et finir lôenregistrement dôun scan Live IVUS en cours.  

 

Ou, 

b. Appuyez sur « Pullback » (Retrait), , pour compléter le scan Live 
IVUS et démarrer immédiatement une acquisition de retrait automatique. 

 

REMARQUE : Apr¯s avoir arr°t® lôacquisition Live IVUS, le contr¹ler 

MakotoÊ affichera la distance parcourue depuis la dernière 

pression sur le bouton « Mark » (Marque). Cette valeur restera 

affich®e jusquô¨ ce que le bouton ç Live IVUS » (IVUS en 

direct), « Pullback » (Retrait), ou « Return to READY » (Retour 

à PRÊT) ou un bouton de translation soit actionné. 
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9.2 Acquisition de retrait automatique 

Une acquisition de retrait automatique démarrera la rotation et le retrait du contrôleur 

MakotoÊ et de lôimagerie du cathéter. Cette action démarrera également la collecte et 

lôenregistrement de données IVUS et NIRS du taux de retrait configuré par lôutilisateur.  

 

  

Figure 9-6 : mode Acquisition avec acquisition de retrait automatique en cours. 

 

9.2.1 Configuration du taux de retrait automatique suivant 

La vitesse de translation pour un retrait automatisé doit être configurée par 

l'utilisateur avant de commencer toute imagerie. Réglez la vitesse de translation 

souhaitée en touchant l'icône du panneau de contrôle du Makoto, . 

Sélectionnez la vitesse souhaitée pour le prochain retrait : 0,5 mm/s, 1,0 mm/s, ou 

2,0 mm/s.  

 

Figure 9-7. Panneau de contrôle du Makoto avec fonctions de contrôle à distance activées. 
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9.2.2 Démarrage du retrait automatique 

Appuyez sur le bouton « Pullback » (Retrait), , du contrôleur MakotoÊ pour 
démarrer une acquisition de retrait automatique. Pendant un retrait, lôIVUS transversal, 
lôIVUS longitudinal, lôindicateur de détection du fil-guide et lôindicateur de spectre sont 
mis à jour en temps réel. 

REMARQUE : Si les fonctions de contrôle à distance sont activées, les 

retraits automatisés peuvent être lancés en touchant l'icône 

« Pullback » (Retrait), , sur le moniteur. Voir la 

section 13.8.7 Activer le contrôle à distance pour activer les 

fonctions. 

 

9.2.2.1 Acquisition de retrait automatique avec aperçu  

Lorsque vous démarrez lôacquisition de retrait automatique depuis lôemplacement PRÊT 

avec le bouton « Pullback » (Retrait), , le système se déplacera dôabord à 

lôemplacement « 0,0 mm » et démarrera lôacquisition Live IVUS. Cela permet un aperçu 

intravasculaire de lôemplacement de démarrage du retrait. Après lôaperçu, appuyez sur 

le bouton « Pullback » (Retrait), , de nouveau pour poursuivre lôacquisition. 

9.2.2.2 Indicateur de spectre  

Au démarrage dôun scan de retrait automatique, le Makoto Intravascular 

Imaging SystemÊ contrôlera la qualité du spectre lumineux enregistré. 

Le système nécessite un nombre minimum de spectres pour générer un 

chemogram. Lorsque des spectres sont enregistrés, lôindicateur de spectre 

se remplira. Il disparaîtra une fois le nombre minimum atteint. 

Remarque : Lorsque le système MakotoÊ collecte suffisamment de données 
nécessaires pour créer un chemogram, lôindicateur de spectre 
disparaîtra de lôécran. 

 

Remarque : Il faut enregistrer environ 12 mm de données numérisées de 
retrait pour avoir suffisamment de données pour générer 
un chemogram. 

 

Remarque : M°me si lôindicateur de bons spectres se remplit en raison de la 

collecte initiale de spectres de bonne qualité, si plus de 12 % 
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dôentre eux sont trop faibles pour contribuer ¨ la g®n®ration du 

chemogram, aucun chemogram ne sera généré. 

 

9.2.3 Arrêt du retrait automatique 

 
AVERTISSEMENT 

Lôimagerie à lôintérieur du cathéter de guidage doit être réduite 

au minimum pour des résultats de chemogram optimaux. 

 

Une fois que la distance de retrait souhaité a été atteinte ou que la quantité de 

données a été enregistrée, le Makoto Intravascular Imaging SystemÊ peut sôarrêter 

de deux manières : 

a. Appuyez sur le bouton « STOP » (ARRÊT), , du contrôleur MakotoÊ ; 

 

Ou 

b. Appuyez sur « STOP » (ARRÊT), , sur lôinterface utilisateur de la console 
MakotoÊ.  

 

Ces deux actions arrêteront les mouvements du contrôleur MakotoÊ et lôacquisition 

de données.  

 

ATTENTION 

En cas dôurgence, utilisez le bouton « STOP » (ARRÊT), , 
du contrôleur MakotoÊ. 

 

Remarque : Le contrôleur MakotoÊ arrêtera automatiquement le retrait si le 
prochain point le plus proche est atteint (emplacement 
150,0 mm). 

 

Remarque : Après avoir arrêté le retrait, le contrôleur MakotoÊ affichera la 
distance parcourue depuis la dernière pression sur le bouton 
« Mark è (Marque). Cette valeur restera affich®e jusquô¨ ce que 
le bouton « Live IVUS » (IVUS en direct), « Pullback » (Retrait), 
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ou « Return to READY » (Retour à PRÊT) ou un bouton de 
translation soit actionné. 

 

  

Figure 9-8 : mode Acquisition après la fin dôun scan de retrait automatique avec un cathéter de guidage. 

Une fois la fin de lôacquisition de retrait, le chemogram, le chemogram bloc et le Lipid 

Core Burden Index (indice de masse du cîur lipidique) seront mis ¨ jour. Lôindicateur 

de détection du fil-guide sera masqué de la vue. Consultez la section 10.2.8 pour plus 

dôinformations. 

 

Si le cathéter de guidage est détecté par le Makoto Intravascular Imaging SystemÊ, 

alors un masque de cathéter de guidage sera appliqué au chemogram, à lôIVUS 

longitudinal et au chemogram bloc. Consultez la section 10.2.7 pour plus dôinformations 

sur la manière de retirer le masque de cathéter de guidage de la vue. 
 

Remarque : Si le masque de cathéter de guidage est activé, la partie du 
chemogram dans le masque de cathéter sera exclue du calcul LCBI. 

 

9.2.4 Marquer ou remettre à zéro pendant le retrait automatique 

Pendant l'acquisition de retrait automatique, des marques peuvent être placées et 

consultées grâce au bouton « Mark è (Marque) du contr¹leur, ¨ lôimage ou ¨ lôic¹ne 

« Mark » (Marque) à l'écran. 

Ajouter une marque pendant lôacquisition de retrait r®initialisera lôaffichage de la 

distance parcourue à 0,0 mm. 

 

Masque de 

cathéter de 

guidage  

Sélection 

de scans  
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9.3 Réalisation de scans supplémentaires avec le Makoto 

Intravascular Imaging SystemÊ 

 

 
AVERTISSEMENT 

Consultez les instructions dôutilisation du cathéter pour le 
guidage de la préparation du cathéter pour des scans 
supplémentaires. 

 

 
AVERTISSEMEN

T 

Des situations dangereuses, y compris des blessures au patient 

ou à l'opérateur, peuvent se produire si les avertissements 

affichés sont ignorés. 

 

 
AVERTISSEMEN

T 

Le mouvement linéaire du contrôleur s'arrête lorsqu'une force 

excessive est rencontrée. 

Vérifiez que le cathéter ne présente pas de pliures, de coudes 

aigus ou de dommages et résolvez-les avant de continuer. 

Appuyez sur « STOP » (ARRÊT), , sur le contrôleur 

MakotoÊ et suivez les instructions ¨ l'®cran pour r®soudre le 

problème. 

 

Nôutilisez PAS les fonctions de translation à une étape pour 

r®gler le probl¯me dôentortillement ou de d®formation. La gaine 

du cathéter pourrait être endommagée ou le patient blessé. 

 

Plusieurs scans peuvent être effectués dans chaque procédure. Le cathéter peut nécessiter 

une quantité supplémentaire de solution saline héparine pour lôimagerie suivante.  
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Appuyez sur le bouton Live IVUS, , ou le bouton « Pullback » (Retrait), , du 
contrôleur MakotoÊ pour acquérir des données supplémentaires. Le scan précédent 
sera sauvegardé et un nouveau scan actif apparaîtra.  

REMARQUE : Si les fonctions de contr¹le ¨ distance sont activ®es, lôimagerie 

IVUS en direct et les retraits automatisés peuvent être lancés 

en touchant l'icône correspondante,  ou , sur le 

moniteur. Voir la section 13.8.7 Activer le contrôle à distance 

pour activer les fonctions. 

 

 

Un nouveau scan créera un nouveau bouton dôactivation du scan pour une révision 
située au-dessus du chemogram. 

 

Remarque : Si vous enregistrez plus de trois scans, utilisez les flèches droite 
et gauche pour amener le bouton scan souhaité dans les vues. 

 

Remarque : Un total de 20 enregistrements par procédure peut être 
sauvegardé. Si la limite est atteinte, effacez les scans non 
souhaités ou fermez la procédure et démarrez-en une nouvelle. 

 

Remarque : Lôannotation dôun nom de scan changera le texte du bouton 
associé. 
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10  Révision, mesure et annotation des scans 

10.1 Sélection de scans 

Après avoir enregistré de nombreux scans, il est possible de commuter entre les scans 

avec les contrôles de sélection du scan. 

 

Figure 10-1 : phase de numérisation du mode Acquisition avec scan « RCA » sélectionné pour révision. 

Appuyez sur le nom de scan souhaité et chargez les données pour lôaffichage à lôécran. 

Vous pouvez voir jusquôà trois scans à tout moment dans la commande de sélection du 

scan. Appuyez sur les contrôles de flèche de chaque côté de la commande de sélection 

du scan pour déplacer dôautres scans dans les vues. 

 

  

Commande 

de sélection 

du scan 

Modifier scan 
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10.2 Modification des scans 

 

  

Figure 10-2 : modifier la fenêtre de scan ouverte pour « RCA». 

Les informations de scan peuvent être modifiées pour fournir des détails 
supplémentaires et faciliter une sélection ultérieure.  

Appuyez sur le bouton Modifier, , du scan sélectionné pour accéder à la fenêtre 

dôédition du scan. Appuyez sur le « X », , ou à lôextérieur de la fenêtre dôédition du 
scan pour fermer ou sauvegarder tous les changements. 

 

10.2.1 Nom du scan 

Le nom du scan peut être personnalisé pour renvoyer des informations sur le scan. Cela 
peut inclure les noms, emplacements ou le timing de lôartère (ex. : « pre » ou « post »). 
Le nom peut être configuré en insérant les informations dans le champ du nom. 

Ce nom de scan apparaîtra dans le répertoire des procédures et scans complétés, 
tout comme les fichiers DICOM et les rapports. 

 
Remarque : Utiliser le filtre dans la phase de sélection du mode Révision 

pour rechercher des noms de scan. Consultez la section 12.1 
pour plus dôinformations. 

 

Fenêtre dôédition 
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10.2.2  Numéro de groupe du cathéter  

Chaque scan est collecté avec un cathéter ayant un numéro de groupe de production 
associé. Cette information peut être enregistrée indépendamment pour chaque scan en 
insérant la valeur du package de cathéter dans le champ du numéro de groupe du 
cathéter dans la fenêtre dôédition du scan. 

 

Remarque : Insérez le numéro de groupe du cathéter pendant la phase de 
configuration pour alimenter automatiquement ce champ pour 
les scans tels quôils sont enregistrés. 

 

Remarque : Utilisez le filtre dans la phase « Select » (Sélection) du mode 
Révision pour rechercher des références de lot de cathéter. 
Consultez la section 12.1 pour plus dôinformations. 

  

10.2.3 Remarque du scan 

Les remarques concernant le scan collecté peuvent être enregistrées dans le champ 

Remarques de la fenêtre dôédition du scan.  

 

Remarque : Utilisez le filtre du mode Révision, de lôécran de la phase de 
sélection pour rechercher des détails importants du scan 
enregistrés dans les remarques du scan. Consultez la 
section 12.1 pour plus dôinformations. 

10.2.4 Scanner la visibilité longitudinale du chemogram au niveau du bloc 

La visibilit® du chemogram au niveau du bloc sur lô®cran IVUS longitudinal peut être 

activ®e ou d®sactiv®e ¨ lôaide de cette case. Ce choix concerne uniquement le scan 

actuel. 

REMARQUE : Le paramètre de visibilité par défaut du chemogram au niveau 
du bloc pour chaque nouveau scan peut être défini dans les 
paramètres du système. Voir section 13.6 Affichage des 
scans. 

 

REMARQUE : Ce paramètre peut être ajusté rapidement en effectuant un 
clic droit avec la souris sur le chemogram au niveau du bloc et 
en choisissant le réglage approprié.  
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10.2.5 Scanner la visibilité transversale du chemogram au niveau du bloc 

La visibilit® du chemogram au niveau du bloc sur lô®cran IVUS transversal peut °tre 

activ®e ou d®sactiv®e ¨ lôaide de cette case. Ce choix concerne uniquement le scan 

actuel. 

REMARQUE : Le paramètre de visibilité par défaut du chemogram au niveau 
du bloc pour chaque nouveau scan peut être défini dans les 
paramètres du système. Voir section 13.6 Affichage des 
scans. 

 

REMARQUE : Ce paramètre peut être ajusté rapidement en effectuant un 
clic droit avec la souris sur le chemogram au niveau du bloc et 
en choisissant le réglage approprié.  

 

10.2.6 Scan mxLCBI 

La taille de fenêtre du LCBI maximale peut être ajustée pour chaque scan par rapport à 

la valeur par défaut. Utilisez le curseur pour ajuster la fenêtre utilisée pour calculer le 

mxLCBI entre 1 mm et 10 mm. 

 

REMARQUE : La valeur par défaut poru tous les nouveaux scans peut être 
définie dans les paramètres du système. Voir section 13.6.5 
« mx LCBI Window Size » (Taille de fenêtre du LCBI max). 

 

10.2.7 Activer le cathéter de guidage 

 

 
AVERTISSEMENT 

Lôimagerie à lôintérieur du cathéter de guidage doit être réduite 

au minimum pour des résultats de chemogram optimaux. 

 

Dans la fenêtre dôédition du scan, utilisez la commande dôactivation du masque du cathéter 

de guidage pour alterner la visibilité du masque du cathéter de guidage sur le chemogram, 

lôindicateur de fil-guide, lôIVUS longitudinal et le chemogram bloc.  
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Figure 10-3 : modification du scan avec masque du cathéter de guidage activé (gauche). Modification du scan 
avec masque du cathéter de guidage désactivé (droite). 

10.2.8 Activer lôindicateur du fil-guide 

Dans la fenêtre dôédition du scan, utilisez la commande dôactivation de lôindicateur  

de fil-guide pour alterner la visibilité de lôindicateur de fil-guide et du chemogram. 

La commande apparaît en bleu lorsque lôindicateur de fil-guide est visible. 

    

Figure 10-4 : la fenêtre dôédition du scan avec lôactivation de lôindicateur de fil-guide activé (gauche) ; le chemogram est 
masqué et lôindicateur de fil-guide est visible (droite). 

 

10.2.9 Effacer scan 

Les scans individuels peuvent être effacés dans la fenêtre dôédition du scan. Une 

demande de confirmation sera fournie à lôutilisateur. 
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cathéter de 
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Figure 10-5 : la commande de scan effacé dans la fenêtre dôédition du scan (gauche) et la demande de confirmation (droite). 

 

ATTENTION 

Une fois confirmée par lôutilisateur, la suppression dôun scan ne 
peut être annulée. 

 

 

10.3 Navigation du scan 

Le scan sélectionné peut être révisé avec plusieurs commandes. 

 

  

Figure 10-6 : phase de numérisation du mode Acquisition avec sélection de scans et commandes de lecture sélectionnées. 
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10.3.1 Lecture automatique 

Appuyez sur la commande Lecture/Pause,  / , située en dessous de lôimage 

IVUS transversale pour répéter automatiquement les images enregistrées dans leur 

ordre dôenregistrement.  

La lecture se produira à environ 16 images par seconde pour les enregistrements Live 

IVUS ou 30 images par seconde pour les enregistrements de retrait automatique. 

 

Figure 10-7 : phase de numérisation du mode Acquisition pendant la lecture automatique avec la commande Pause 
sélectionnée. 

La mise sur pause arrêtera la lecture sur lôimage affichée. La reprise de la lecture 

démarrera par la répétition des images à partir du dernier fragment affiché. 

 

Remarque : Une fois la dernière image enregistrée atteinte, la lecture en 
boucle reprendra par la première image des séries. 

 

Remarque : Lorsquôune région est sélectionnée, la lecture automatique 
tournera les images dans la région sélectionnée. 

 

10.3.2 Révision de la lumière 

Comme une aide pour réaliser les mesures et réviser les images individuelles, la 

révision de la lumière lira une très courte boucle des images pour accentuer les 

différences dans lôapparence IVUS de la cuve et de la plaque immobiles du mouvement 

relatif à la circulation sanguine. 

La révision de la lumière activée en appuyant sur la commande de révision de la 

lumière, , à droite du bouton de lecture automatique. 

Pause  
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REMARQUE : Il est possible dôajuster la dur®e ou la plage de la r®vision du 
flux lumineux dans les paramètres du système. Voir section 
13.6.2 Plage dôimages de la r®vision du flux lumineux. 

 

10.3.3 Lecture manuelle 

Le scan sélectionné peut également être lu manuellement. Appuyez et relâchez la 

commande de sélection de lôimage fine, , pour lire le scan lentement dans 

la direction de votre choix. Ainsi, la lecture sôarrêtera une fois lôimage atteinte par le 

scan ou la région sélectionnés ; cela ne fermera pas les images sélectionnées.  

Remarque : Appuyez et relâchez la commande de sélection de lôimage fine, 

, pour lire les images sélectionnées dans leur ordre 

inverse dôenregistrement. 

 

10.3.4 Sélection de lôimage 

10.3.4.1 Sélection de lȭimage approximative  

Faites glisser la commande de s®lection de lôimage approximative entre le chemogram 

ou la carte de détection du fil-guide et lôIVUS longitudinal ou tout autre endroit sur la 

ligne bleue pour actualiser rapidement lôimage affich®e.  

 

Remarque : Le déplacement de la commande de sélection de lôimage 
approximative est une lecture à taux variable. 

 

10.3.4.2 Sélection de lȭimage fine 

Appuyez sur lôimage fine approximative ou les commandes de sélection de lôimage fine 

distale, , pour changer lôimage affichée en augmentation dôune image. 

 

Remarque : Avec le curseur au-dessus du chemogram, de lôindicateur de fil-
guide, de lôIVUS transversal ou de lôIVUS longitudinal, faites défiler 
la molette de la souris pour changer lôimage affichée en 
augmentation dôune image. 
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10.4  Marques 

Pendant et après que le scan soit complété, des marques peuvent être placées. 

Pendant lôacquisition du scan, appuyez sur les commandes « Mark » (Marque),  

ou . Pendant la révision, naviguez sur lôimage souhaitée et appuyez sur « Mark » 

(Marque) à lôécran. 

 

Remarque : Une seule marque peut être placée sur chaque image. 

 

Remarque : Jusquô¨ 30 marques peuvent être créées dans un seul scan. 

 

Remarque : Jusquôà cinq marques peuvent être vues complètement à lôécran 
à tout moment. 

 

Remarque : Compléter une mesure IVUS transversale ou sur une annotation 
dôimage créera automatiquement une marque pour lôimage. 

 

Remarque : Utilisez le bouton « Mark » (Marque) dans les phases de 
configuration ou dôamor­age pour passer ¨ la phase suivante du 
mode Acquistion. 

 

Remarque : Pendant lôacquisition dôimages, utilisez le bouton ç Mark è 
(Marque) pour réinitialiser les distances affichées à 0 mm. 

 

La position relative dôune marque dans le scan est indiquée par de petits triangles verts 

sur le chemogram et lôIVUS longitudinal. Lorsque la marque est sélectionnée, lôimage 

affichée en cours connectera les triangles. 
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Figure 10-8 : Les emplacements de marque sont affichés par les indicateurs de triangle vert du chemogram et de lôIVUS 
longitudinal et avec une vignette visuelle affichant le contenu de lôimage. 

 

10.4.1  Sélection de marques 

Une vignette de marque sera créée pour chaque marque placée. La vignette est la 

commande pour sélectionner lôemplacement marqué pour une révision ultérieure. Elle 

fournit également une représentation visuelle du contenu à lôemplacement de lôimage. 

Appuyez sur lôimage de la marque souhaitée pour mettre à jour lôécran et afficher 

lôimage dans lôécran de lôIVUS transversal. 
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10.4.2  Modifications de marques 

Les marques peuvent être effacées ou annotées. Appuyez sur le bouton Modifier, , 

de la marque sélectionnée pour ouvrir la fenêtre dôédition de marque. 

Appuyez sur « X », , ou à lôextérieur de la fenêtre dôédition de marque pour fermer 

la fenêtre, en sauvegardant les changements. 

10.4.2.1  Notes de marque 

 

 

Figure 10-9 : note de marque saisie dans la fenêtre dôédition de marque. 

Des remarques concernant le contenu dôune image peuvent être enregistrées dans le 

champ Notes de la fenêtre dôédition de marque. 

 

10.4.2.2 Suppression 

Les marques peuvent être supprimées avec la commande « Delete » (Supprimer), , 

dans la fenêtre dôédition de marque.  

Remarque : La suppression de marque ne peut être annulée. 

 

Remarque : La suppression dôune marque comprenant des mesures ou des 
annotations dôimage nécessitera une confirmation. 

 

 

10.4.3 Impression 

Les rapports de marque sont condensés en une page de résumés de la procédure 

basée sur les résultats dans lôimage sélectionnée. 
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Sur la marque sélectionnée, appuyez sur le bouton Imprimer, , pour envoyer un 

rapport dôune page à lôimprimante configurée par défaut pour le système. 

 

10.5 Mesures 

Le système dôimagerie Makoto fournit des commandes avec la phase de numérisation 

pour effectuer des mesures de lôaffichage transversal et des affichages longitudinaux 

(Chemogramet IVUS longitudinal).  

 

Figure 10-10 : phase « View » (Visualisation) avec une région sélectionnée dans le scan « RCA ». 

 

10.5.1  Mesure de la longueur, de la sténose de la zone de lumière et du LCBI 

Les mesures de la longueur, de la sténose de la zone de lumière et du LCBI sont effectuées 

sur la vue de lôIVUS longitudinal et du chemogram à travers la création de régions. 

10.5.1.1 Création de régions 

Les régions sont les sous-segments dôun scan importants pour lôopérateur ou le médecin. 

Ces segments peuvent concerner les lésions, les segments normaux, les stents...  
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Figure 10-11 : phase « View » (Visuealisation) avec création de région en cours. Les consifnes pour terminer la région 
apparaissent ¨ lô®cran. 

 

Les régions sont créées en appuyant sur la commande Longueur, , puis en 

indiquant un emplacement de début et de fin de la région sur lôIVUS longitudinal ou 

chemogram. Il est possible de définir la région : 

(A) En appuyant et en maintenant au niveau de la position de départ souhaitée 

puis en étirant jusquôà la position de fin souhaitée ; 

ou  

(B) En appuyant sur les positions de marques de départ et de fin dans les 

vignettes de marque. 

Remarque : Utilisez les marques pour définir le début ou la fin dôune région 
souhaitée avec une précision accrue. 

 

Une fois la région créée, les zones de lôaffichage longitudinal situées en dehors de la 

région sôestompent et un contrôle de sélection de la région sôaffiche sous les contrôles 

de sélection de scan. 

Remarque : 

Utilisez le bouton de lecture, , pour créer une boucle avec la 
région sélectionnée. 

 

Le LCBI et les résultats sôaffichent à gauche de la région du chemogramet la longueur 

sôaffiche à gauche de lôIVUS longitudinale. 
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Figure 10-12 : phase « View » (Visualisation) avec la région sélectionnée. 
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10.5.1.2  Modification des régions  

Il est possible de modifier la position ou lôemplacement de d®but et de fin des r®gions 

qui ont été créées dans le chemogram. 

  

Figure 10-13. Commandes de modification des régions 

Faites glisser la position de la région pour déplacer la région définie sans en modifier la 

longueur. 

Faites glisser la limite proximale ou distale de la région pour ajuster de manière 

grossi¯re lôextr®mit® s®lectionn®e de la r®gion. La longueur de la r®gion s'adaptera 

automatiquement. Les LCBI s'actualiseront lorsque la modification sera terminée. 

 

REMARQUE : Placez le curseur sur les commandes de modification du 
début ou de la fin et utilisez la roulette de la souris pour 
effectuer des ajustements pr®cis de lôemplacement de la limite 
de la région. 

 

REMARQUE : Verrouillez la région pour éviter tout ajustement accidentel. 
Voir section10.5.1.7 Verrouiller une région. 

Modification 

de la position 
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Modification 
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10.5.1.3 Longueur, LCBI et LCBI max  

Une fois terminée la création de région, trois résultats de mesure liés à la région 

sôaffichent. 

 Longueur : Il sôagit de la distance en millimètres (mm) entre la 
position de début et la position de fin de la région. 

 LCBI : Il sôagit du Lipid Core Burden Index (Indice de masse 
du cîur lipidique) de la r®gion. Le LCBI est le ratio des 
signaux positifs de lipides et du total de pixels valides 
dans la région sélectionnée, exprimé sur une échelle 
de 0 à 1000. 

 mx(4) : Il sôagit du Lipid Core Burden Index maximum dôune 
taille fixe de fenêtre dans les limites de la région. 
La taille de fenêtre par défaut est de 4 mm. 

10.5.1.4 Sténose de lȭaire de la lumière (AS%)  
Il est possible de calculer la sténose de lôaire (Area Stenosis ou AS) de la lumière en 
utilisant deux marques contenant chacune une mesure dôaire que le système a 
identifiée comme correspondant à la lumière.  

Remarque : Ajoutez les mesures de lumière à lôimage de début et à lôimage 
de fin dôune région existante pour obtenir la sténose de lôaire de 
la lumière pour la région en question. 

 

10.5.1.5 Sélection et désélection 

Sélectionnez les régions en appuyant sur le bouton correspondant au niveau du 

contrôle de sélection de région. Lôaffichage longitudinal, la longueur, le LCBI et le LCBI 

max sont actualisés en conséquence. 

Désélectionnez les régions en appuyant à nouveau sur le bouton de région 

correspondant ou sélectionnez le scan actuel ou un autre scan.  

 

Remarque : Le fait de créer une nouvelle région désélectionne la région 
actuelle. 
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10.5.1.6  Annotation de la région  

 

  

Figure 10-14 : nom de région saisi dans la fenêtre de modification de la région. 

Appuyez sur le bouton « Edit » (Modifier), , du bouton « Selected Region » 

(Région sélectionnée) pour ouvrir la fenêtre « Region Edit » (Modifier la région). 

Appuyez sur le champ souhaité pour en modifier le contenu. 

Appuyez sur le « X », , ou à lôextérieur de la fenêtre « Region Edit » (Modifier la 

région) pour fermer ou sauvegarder votre saisie. 

 

10.5.1.7 Verrouiller une région  

Appuyez sur le bouton « Edit » (Modifier),  , du bouton « Selected Region » (Région 

sélectionnée) pour ouvrir la fenêtre « Region Edit » (Modifier la région). Appuyez sur 

lôic¹ne ç Region Lock » (Verrouillage de la région),  , pour autoriser ou 

emp°cher lôajustement de la position ou des limites de la région. 
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10.5.1.8 Suppression de région 

Appuyez sur le bouton « Edit » (Modifier), , du bouton « Selected Region » (Région 

sélectionnée) pour ouvrir la fenêtre « Region Edit » (Modifier la région). Appuyez sur le 

bouton « Delete » (Supprimer), , pour supprimer la région.  

Remarque : La suppression dôune région ne peut être annulée. 

 

10.5.2  Mesure sur image  

Il est possible dôeffectuer des mesures sur toute image transversale dôIVUS afin de 

clarifier ou de quantifier le contenu de lôimage. 

 

Remarque : Effectuer une mesure sur image crée automatiquement une 
marque pour lôimage. 

 

Remarque : Effectuer une mesure sur image actualise lôimage de la vignette 
de marque. 

 

REMARQUE : Lorsque lôoutil est actif, appuyez sur lôoutil pour abandonner la 
mesure ou lôannotation sur lôimage en cours. 

 

10.5.2.1 Mesure de zone 

Lôoutil de mesure de zone, , peut être utilisé pour mesurer lôaire ainsi que les 

diamètres minimum et maximum des éléments à lôimage. 
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Figure 10-15 : Phase « Scan » (Numérisation) avec mesure de la zone activée et en cours. Le premier point placé est 
indiqué par un plus grand cercle plein. 

 

Appuyez sur lôoutil de mesure de zone, , pour commencer à mesurer. Lôicône 
devient bleue lorsquôelle est active. Des instructions sôaffichent au-dessus de lôimage 
transversale dôIVUS et servent de guide pour terminer la mesure. 
 
Appuyez sur lôimage transversale dôIVUS pour placer les points le long de lôélément 
souhaité afin de commencer à définir la zone. Continuez à ajouter des points jusquôà 
ce que la zone soit définie. 
 

Remarque : Lorsque le troisième point est ajouté pour définir la zone, un 
aperçu de la zone apparaît en pointillés. Il illustre la manière 
dont la zone termin®e appara´tra si lôutilisateur appuie sur le 
point de départ pour compléter la zone. 

 
 

Remarque : 

Appuyez sur « Cancel » (Annuler), , au niveau des 
instructions à lôécran pour abandonner la mesure en cours. 
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Figure 10-16 : mesure de zone terminée et affichage des résultats. 

Appuyez sur le premier point pour terminer la mesure et afficher les résultats. Pour 
chaque zone terminée, la zone transversale avec diamètres minimum et maximum 
sôaffichera dans le coin supérieur gauche de lôimage transversale dôIVUS. 
 

Remarque : Appuyez sur le résultat de mesure pour afficher les diamètres 
minimum et maximum dans lôimage. 

 
 

Résultats 
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Figure 10-17 : Des contours et résultats codés par couleur sôaffichent si une zone tracée est totalement imbriquée dans une 

seconde zone. Le contour de la lumière est sélectionné et les emplacements des diamètres minimum et maximum sont indiqués. 

 

Sôil y a plus dôun contour de zone tracé, les résultats seront codés par couleur. 
 

Remarque : Trois zones peuvent être tracées sur chaque image. 

 

Remarque : Chaque r®sultat de mesure dôune zone poss¯de la m°me 
couleur que son contour. Chaque icône de zone calculée, par 
exemple une zone de plaque, correspond à la couleur utilisée 
pour les contours qui servent à définir le résultat de la zone 
calculée. 

 
Remarque : Si une zone est toalement imbriquée dans une seconde zone 

sur la même image, le syst¯me MakotoÊ en d®signera 
automatiquement une pour représenter la « Lumière è et lôautre 
« EEM è, tandis quôune zone de plaque et une progression de 
plaque, « PP » seront calculées. 

 
Remarque : Si trois zones impriquées apparaissent sur la même image, la 

zone 1 trac®e enti¯rement ¨ lôint®rieur de la zone 2 et la zone 2 
enti¯rement ¨ lôint®rieur de la zone 3, le syst¯me MakotoÊ 
d®signera automatiquement la zone la plus ¨ lôext®rieur pour 
représenter « EEM è, celle la plus ¨ lôint®rieur pour repr®senter 
la « Lumière », et celle du millieu pour représenter le « Stent ». 
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Une zone de plaque et une progression de plaque, « PP », 
seront calculées entre « EEM » et la « Lumière ». Une autre 
zone sera calculée entre le « Stent » et la « Lumière ». 

 
 
Ajustez la taille ou la forme de la zone en appuyant sur les points existants et en les 
faisant glisser vers lôemplacement d®sir®. Pour affiner la forme de la zone termin®e, 
ajoutez des points à la zone terminée et faisant glisser le contour de la zone entre les 
points existants. Les résultats présentés s'actualiseront lorsque la modification sera 
terminée. 
 

Remarque : Faites glisser les points de mesure pour ouvrir le zoom local et 
améliorer la visualisation de lôimage près du curseur ou sous le 
doigt de lôopérateur. 

 

10.5.2.2 Mesure linéaire  

Il est possible dôeffectuer des mesures linéaires au niveau de lôimage transversale dôIVUS 

pour mesurer des éléments de lôimage, comme des diamètres ou des épaisseurs.  

 

 

Figure 10-18 : Mesure linéaire terminée. Trois mesures linéaires ont été faites sur cette section. 

Supprimer la 

mesure 

Mesure 

sélectionnée 

Mesure linéaire 
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Appuyez sur lôoutil de mesure linéaire, , pour commencer à mesurer. Lôicône 

devient bleue lorsquôelle est active. Des instructions sôaffichent au-dessus de lôimage 

transversale dôIVUS et servent de guide pour terminer la mesure. 

 
Appuyez sur le point de d®part de la fonction ¨ mesurer sur lôimage IVUS transversale.  
Appuyez sur la position de fin de la fonction pour terminer la mesure. La mesure linéaire 
entre les deux points s'affichera en millim¯tres sur lôimage IVUS transversale. 
 

Remarque : Lorsque vous utilisez la souris ou faites glisser le point de fin, un 
aper­u de la ligne et de la distance appara´t jusquô¨ ce que vous 
placiez le point de fin. 

 
Remarque : Il est possible de tracer jusquôà six mesures linéaires par image. 

 
Faites glisser le point de début ou de fin pour ajuster la mesure.  
 

10.5.2.3  Supprimer des mesures sur image 

Pour supprimer des mesures sur image individuelles, commencez par sélectionner le 

résultat de mesure. 

 

Figure 10-19 : marque avec une mesure linéaire sélectionnée. Notez lôoption permettant de supprimer la mesure et le résultat. 

Lorsque vous sélectionnez une mesure, un bouton « Delete » (Supprimer), , 

sôaffiche à gauche du résultat sélectionné. Appuyer sur le bouton « Delete » 

(Supprimer), , efface la mesure et le résultat du scan. 

Remarque : La suppression de mesure ne peut pas être annulée. 

Supprimer la 

mesure 
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Remarque : Aucune confirmation nôest demandée lors de la suppression de 
mesures individuelles. 

 

Remarque : Supprimez la marque pour effacer TOUTES les mesures dôune 
image en une fois. 

10.6  Annotation sur image 

Outre les mesures, il est possible de placer des commentaires directement sur 

lôimage transversale dôIVUS.  

Appuyez sur le bouton dôannotation sur image, , pour commencer à créer 

des commentaires sur image. Déterminez lôemplacement où la note devra 

sôafficher, qui correspondra au bord gauche de la note. Appuyez sur <Enter> 

(<Entrée>) sur le clavier virtuel pour terminer lôannotation. 

 

Remarque : Effectuer une annotation sur image crée automatiquement une 
marque pour lôimage. 

 

Remarque : Vous pouvez faire glisser les annotations sur image terminées 
vers un nouvel emplacement sur lôimage actuelle. 

 

Remarque : Terminer une annotation sur image actualise lôimage de la 
vignette de marque. 

 

Pour supprimer une annotation sur image, appuyez sur lôannotation pour la 

sélectionner puis appuyez sur le bouton « Delete » (Supprimer), . 

 

10.7 Capture dôécran 

Vous pouvez effectuer des captures de la totalité de lôécran lors des phases « Scan » 

(Numérisation) et « View » (Visualisation). Cette image capturera tout le contenu à 

lôécran ainsi que tous les boutons et commandes. 

Lorsque vous examinez un scan, naviguez jusquôà lôimage souhaitée à lôaide des 

commandes de réglage grossier ou fin de lôimage. 
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Figure 10-20 : phase « Scan » (Numérisation) du mode Acquisition avec le bouton de capture dôécran indiqué. 

Appuyez sur le bouton Capture, , pour enregistrer une image de lôécran entier pour 

un usage ultérieur. 

 

Remarque : Vous pouvez enregistrer jusquôà 30 captures dôécran par scan. 

 

Remarque : Il est possible dôimprimer ou de supprimer des captures dôécran 
depuis la phase « Close » (Fermeture) du mode Acquisition ou 
depuis la phase « Select » (Sélection) du mode Révision. 

 

10.8 Paramètres dôaffichage 

Le Makoto Intravascular Imaging SystemÊ propose plusieurs boutons permettant 

dôoptimiser la disposition de lôaffichage et la qualité des images obtenues par IVUS.  

10.8.1 Rotation longitudinale dôIVUS 

Lôimage longitudinale dôIVUS est créée à partir des données dôimage le long de lôaxe 

marqué au niveau de lôimage transversale dôIVUS. Lôaxe marqué au niveau de lôimage 

transversale dôIVUS est indiqué par les triangles solides et ouverts sur lôaxe. Le triangle 

solide sur lôaxe indique la portion de lôimage qui sera tracée dans la moitié supérieure 

de lôIVUS longitudinale. 

Capture 

dô®cran 
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Figure 10-21 : rotation longitudinale dôIVUS. La ligne verte en pointillés indique lôemplacement initial de lôaxe de lôIVUS 
longitudinale, et la ligne solide son emplacement actuel. Les lignes sont accentuées ici à des fins dôillustration. 

Pour ajuster les donn®es affich®es dans lôIVUS longitudinale, faites glisser le triangle 

plein sur lôaxe marqu® jusquô¨ un nouvel emplacement sur la circonf®rence de lôimage 

IVUS transversale. 

 
REMARQUE : Ajuster cet affichage de lôIVUS longitudinal nôaffecte pas les 

ajustements apportés à la rotation du chemogram. 

 

10.8.2 Rotation du chemogram 

 

  

Figure 10-22 : Il est possible de faire pivoter les chemograms de manière à éloigner les groupes de lipides du bord du 
chemogram afin de faciliter lôexamen et lôinterpr®tation. 

Lôaxe vertical du chemogram est une dimension continue de 360°. Cela signifie que le 

bord sup®rieur du chemogram est reli® au bord inf®rieur. Lôemplacement de la coupe 

est arbitraire et permet de la représenter sur un plan en deux dimensions. Certains 

éléments peuvent dès lors être séparés entre les bords supérieur et inférieur. 



Makoto Intravascular Imaging SystemTM 
Guide dôutilisation 

   
IFU0163rK.fr (2022-04-04)  10-27 

Appuyez ou cliquez dans le chemogram et faites glisser verticalement pour ajuster 

lôemplacement de la coupe du chemogram. 

 

REMARQUE : Le syst¯me se souviendra de lôajustement de la ligne de 
coupe du chemogram et lôutilisera lors des consultations de 
scans ou générations de rapports suivantes. Les captures 
dô®cran ne seront pas ajust®es. 

 

REMARQUE : Ajuster cet affichage du chemogram nôaffecte pas les 
ajustements apport®s ¨ lôIVUS longitudinal. 

 

10.8.3 Rotation de lôIVUS transversale 

 Il est possible de faire pivoter l'image transversale afin de faciliter la comparaison avec 

d'autres scans ou dôaider lôutilisateur ¨ mieux visualiser l'anatomie. 

 

Figure 10-23. Rotation de lôIVUS transversale. Lôimage de gauche montre lôorientation par d®faut et lôimage de droite 
montre lôimage apr¯s rotation, effectu®e en faisant glisser la commande sur le halo du chemogram vers un nouvel 

emplacement. 

Pour ajuster la rotation de lôimage transversale, faites glisser la commande de l'arc gris 

qui apparaît dans le halo du chemogram vers un nouvel emplacement. 
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REMARQUE : Les orientations de l'image IVUS transversale et du halo du 
chemogram sont liées. Faire pivoter l'image transversale fait 
également pivoter le halo du chemogram. 

 

REMARQUE : La rotation de lôimage transversale s'applique ¨ toutes les 
images du scan. 

 

REMARQUE : La rotation de lôIVUS longitudinale est relative ¨ la rotation de 
lôIVUS transversale, de sorte que les ajustements de la 
rotation de lôIVUS transversale ne perturberont pas la vue de 
lôIVUS longitudinale s®lectionn®e. 

 

REMARQUE : La rotation de lôIVUS transversale appara´tra dans les 
rapports, AVIS et images DICOM créés dans le mode 
Révision. 

 

10.8.4 Paramètres de lôimage transversale 

Il est possible dôajuster lôimage transversale de lôIVUS à lôaide des boutons de 

paramètres dôimage. Ces boutons incluent un ensemble de commandes de base ainsi 

quôun ensemble de commandes avancées. 

  

Figure 10-24 : paramètres de lôimage transversale. À gauche, les commandes de base. À droite, les commandes avancées. 

Appuyez sur le bouton des paramètres dôimage pour y accéder puis utilisez le bouton 

Étendre, , pour accéder aux paramètres et fonctions avancés. 

Appuyez sur la croix, , ou à lôextérieur de la fenêtre pour utiliser les paramètres 

actuels et fermer la fenêtre. 

10.8.4.1 Zoom  

Vous pouvez ajuster la profondeur de champ de lôIVUS transversale à lôaide des 

commandes de zoom à côté de lôimage transversale dôIVUS. Il est possible 

 Étendre les 

commandes 
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dôajuster la profondeur dôimage transversale dôIVUS de 6 à 16 mm, par 

incréments de 2 mm. 

         

Figure 10-25 : les commandes de zoom permettent dôajuster le diamètre dôIVUS transversale. 6 mm de diamètre, à gauche. 
10 mm de diamètre, au centre. 16 mm de diamètre, à droite. 

Appuyez sur les commandes de zoom pour augmenter, , ou réduire , 

le zoom sur lôIVUS transversale. Lôaffichage de lôIVUS longitudinale sera actualisé 

en conséquence. 

 

10.8.4.2 Gain  

Faites glisser le curseur pour ajuster la valeur du paramètre de gain. La valeur est 

comprise entre 0,5 et 3,0.  

Une valeur basse produit une image sombre, tandis quôune valeur élevée produit une 

image plus claire. 

10.8.4.3 Saturation  

Faites glisser le curseur pour ajuster la valeur du paramètre de saturation. La valeur est 

comprise entre 0,50 et 1,50.  

Une valeur basse produit une image sombre, tandis quôune valeur élevée produit une 

image plus claire. À utiliser conjointement au paramètre de Noir pour contrôler la plage 

dynamique. 

10.8.4.4 Noir  

Faites glisser le curseur pour ajuster la valeur du paramètre de noir. La valeur est 

comprise entre 0,00 et 0,50.  

Une valeur basse produit une image claire, tandis quôune valeur élevée produit une 

image plus sombre. À utiliser conjointement au paramètre de saturation pour contrôler 

la plage dynamique. 

Zoom 

Diamètre de 

champ dôIVUS 



Makoto Intravascular Imaging SystemTM 
Guide dôutilisation 

   
IFU0163rK.fr (2022-04-04)  10-30 

10.8.4.5 Gamma  

Faites glisser le curseur pour ajuster la valeur du paramètre gamma. La valeur est 

comprise entre 0,5 et 2,6.  

Une valeur basse produit une image plus blanche, tandis quôune valeur élevée produit 

une image plus sombre. 

10.8.4.6 Revenir au réglage précédent  

Appuyez sur le bouton Revenir aux paramètres précédents , pour réinitialiser les 

paramètres aux valeurs quôils avaient au moment dôouvrir la fenêtre de paramètres. 

Cela nôa aucun effet sur le zoom.  

10.8.4.7 Enregistrer comme paramètres locaux par défaut  

Appuyez sur le bouton Enregistrer en local, , pour enregistrer les paramètres 

actuels comme paramètres par défaut. Toutes les nouvelles procédures démarreront avec 

ces paramètres dôimage, à lôexception du zoom.  

Ces valeurs seront utilisées lorsque vous appuyez sur le bouton Return to Local 

Settings (Revenir aux paramètres locaux).  

10.8.4.8 Revenir aux paramètres locaux  

Appuyez sur le bouton Revenir aux paramètres locaux, , pour charger les 

paramètres locaux par défaut. 

10.8.4.9  Revenir aux paramètres dȭusine  

Appuyez sur le bouton Revenir aux paramètres dôusine, , pour charger les 

paramètres par défaut établis par le fabricant. 
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11  Clore les procédures 
Lors de la phase « Close » (Fermeture) de la procédure, il est possible dôexaminer les 

détails de la procédure avant dôenregistrer les scans et lôanalyse dans la mémoire locale 

du système. 

 

Figure 11-1 : phase « Close » (Fermeture) du mode Acquisition avec la commande « Close procedure » (Fermer la 
procédure) activée. 

Les détails de la configuration, des scans recueillis, des marques et des captures 

dôécran sont affichés pour confirmation. Côest lôoccasion dôévaluer les données de la 

phase « Setup » (Configuration) ou de supprimer les scans indésirables avant de clore 

la procédure.  

 

Remarque : Si des informations essentielles nécessaires pour identifier une 
proc®dure sont manquantes, lôop®rateur sera invit® ¨ retourner ¨ 
la phase « Setup » (Configuration). 

 

Remarque : Si un scan est initié depuis le contrôleur MakotoÊ, le mode 
Acquisition reviendra automatiquement à la phase de scan. 

 

Si des modifications sont requises, appuyez sur le bouton « Return to scan » (Revenir 

au scan) ou « Edit » (Modifier), , ou appuyez sur la phase appropriée sur le ruban 

de progression pour modifier la procédure. 

Appuyez sur « Close Procedure » (Fermer la procédure), , confirmez que 

vous souhaitez enregistrer tous les scans dans la mémoire locale et réinitialisez le 

mode Acquisition pour une nouvelle procédure.  

Clore la 

procédure  

Revenir au 

scan  

Modifier les 

informations 

de procédure  



Makoto Intravascular Imaging SystemTM 
Guide dôutilisation 

   
IFU0163rK.fr (2022-04-04)  12-1 

12  Procédures dôévaluation et dôarchivage 
Il est possible dôévaluer, dôarchiver, de modifier et de supprimer les procédures 

enregistrées précédemment en mode Révision.  

Pour passer en mode Révision depuis le mode Acquisition, appuyez sur le bouton de 

mode Makoto lorsquôaucune procédure nôest en cours. 

 

 

Figure 12-1 : mode Révision affichant la phase « Select » (Sélection). 

En entrant en mode Révision, lôopérateur voit apparaître la phase « Select » (Sélection) 

du flux de travail de révision. Lors de cette phase, lôopérateur sélectionnera les 

procédures et scans sur lesquels effectuer des actions supplémentaires. Lôopérateur 

peut choisir de modifier, afficher, supprimer ou imprimer des rapports relatifs à la 

procédure ou aux scans sélectionnés. 

Il est également possible de sélectionner des scans pour les importer dans la mémoire locale.  
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12.1  Sélectionner des procédures et scans 

Il est possible de sélectionner des procédures et scans individuels pour effectuer des 

actions supplémentaires dans la phase « Select » (Sélection) du mode Révision. 

Les données contenues dans le système sont disposées dans trois tableaux, en fonction 

du type dôinformations. Il y a un tableau pour les procédures, pour les scans de la 

procédure sélectionnée, et pour les marques et captures dôécran du scan sélectionné. 

 

Figure 12-2 : phase « Select » (Sélection) du mode Révision avec indication des différentes listes dôinformations. 

Vous pouvez afficher les procédures sélectionnées ou imprimer les captures dôécran ou 

rapports de marques. Vous pouvez exporter et afficher les procédures cochées. Si la 

procédure cochée est aussi la sélection actuelle, vous pouvez imprimer ses captures 

dôécran ou rapports de marques. 

Pour sélectionner une seule procédure, appuyez à nôimporte quel endroit sur la ligne 

dôinformations de la procédure dans la liste de procédures. La procédure sélectionnée 

devient la sélection actuelle. Les scans de cette procédure sôaffichent dans la liste 

de scans.  

Cochez les cases pour sélectionner plusieurs procédures afin dôexporter des lots de 

données depuis le système. 

 

Remarque : Par défaut, les procédures seront classées en commençant par 
la date de procédure la plus récente en haut de la liste. 

 

Remarque : Les scans seront classés par défaut dans lôordre chronologique, 
le scan le plus ancien étant en haut de la liste. 
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Remarque : Appuyez sur les en-têtes de colonnes des listes de procédures 
et de scans pour modifier le classement des informations. 

 

Remarque : Lorsquôune procédure est cochée, tous les scans quôelle 
contient sont cochés par défaut. 

 

Pour sélectionner plusieurs procédures, appuyez sur la case à cocher à côté des 

informations de la procédure souhaitée. Enlevez les procédures dôune sélection multiple 

en appuyant à nouveau sur la case à cocher. 

Remarque : Lôexportation personnalisée nôest possible que pour une seule 
procédure. 

 

12.1.1 Historique de scans 

Les modifications apportées aux scans après la procédure seront enregistrées dans 

lôhistorique de scans. Ceci inclut les modifications portant sur le nom de scan, les ajouts 

ou suppressions de marques, et les actions dôexportation ou dôarchivage. 

 

12.1.2 Filtrer la liste de procédures 

Entre lôarchivage de routine et la suppression des données du système, le catalogue de 

procédures enregistrées peut devenir fort long. Utilisez un filtre par terme pour réduire 

le nombre dôentrées affichées dans la liste de procédures et faciliter la sélection.  

 

  

Figure 12-3 : phase « Select » (Sélection) avec filtre appliqué aux listes de procédures et de scans pour les entrées 
contenant le mot « Sample ». 

 

Saisissez un court volume de texte dans la case de filtre, cela réduira la liste à un 

nombre dôentrées plus facilement gérable.  
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Le système recherchera ces caractères dans les ID de procédure, noms de patients, 

ID de patients, noms de médecins, références de lot de cathéter ou notes de scan. 

Appuyez sur Effacer, , pour revenir à la liste complète des procédures. 

 

12.1.3 Modifier la procédure 

Vous pouvez modifier les informations de procédures ou de patients pour rectifier ou 

mettre à jour des informations. Dans la liste de procédures comprenant la sélection 

actuelle, appuyez sur lôicône Modifier, , pour ouvrir la fenêtre « Edit Procedure » 

(Modifier la procédure). 

Les détails de la procédure actuelle sôaffichent dans la fenêtre « Edit Procedure » 

(Modifier la procédure). Utilisez les commandes disponibles pour mettre à jour 

les champs.  

 

 

Figure 12-4 : phase « Select » (Sélection) avec fenêtre « Edit Procedure » (Modifier la procédure) ouverte. 

 

Appuyez sur « Save » (Enregistrer), , pour enregistrer les modifications et fermer 

la fenêtre. Appuyez sur « Cancel » (Annuler), , pour fermer la fenêtre sans 

enregistrer les modifications.  
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Remarque : Les modifications apportées à la procédure affecteront tous les 
scans associés à la procédure dans le système. Ceci inclut les 
scans non cochés. 

 

Remarque : Affichez la procédure pour modifier les détails de scans inclus 
dans la procédure sélectionnée. 

 

 

12.1.4 Imprimer le rapport  

Vous pouvez imprimer des rapports complets sur une sélection dôune ou de plusieurs 

procédures depuis le Makoto Intravascular Imaging SystemÊ en utilisant une 

imprimante compatible configurée. 

 

Remarque : Contactez votre représentant commercial local ou le service 
client Infraredx pour plus dôinformations sur les imprimantes 
compatibles et leur configuration. 

 

Les rapports complets incluront un résumé de tous les scans effectués dans une 

procédure, y compris les régions créées et les marques et mesures effectuées. Pour 

imprimer un rapport complet, sélectionnez une procédure en cochant la case à côté de 

lôentrée dans la liste de procédures, puis en appuyant sur le bouton « Print » (Imprimer 

le rapport de procédure), . 

 

Figure 12-5 : phase « Select » (Sélection) avec indication du bouton Print Mark Report (Imprimer le rapport de marques). 
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Sélectionnez une marque ou une capture dôécran et appuyez sur « Print » (Imprimer), 

, pour envoyer un rapport de marques dôune page ou une capture dôécran vers 

lôimprimante. 

 

Remarque : Le contenu du rapport de marques est inclus dans le rapport 
complet pour la procédure. 

 

12.1.5  Afficher  

Pour afficher, modifier, analyser et supprimer des scans inclus dans la procédure 

actuellement sélectionnée, appuyez sur le bouton « View » (Afficher), . Ceci 

charge tous les scans de la procédure actuellement sélectionnée dans la phase 

« View » (Visualisation) du mode Révision. 

Vous pouvez naviguer, afficher, modifier et supprimer la procédure et les scans de la 

même manière que dans la phase « Scan » (Numérisation) du mode Acquisition.  

Reportez-vous à la section 10 Révision, mesure et annotation de scans pour plus 

dôinformations et de conseils. 

 

Figure 12-6 : phase « View » (Visualisation) du mode Révision. 

 

Remarque : Les modifications apportées aux marques, régions, mesures et 
annotations lors de la phase « View » (Visualisation) seront 
intégrées aux données de procédure enregistrées lorsque vous 
revenez à la phase de sélection. 
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Appuyez sur « Select » (Sélectionner), , sur le ruban de progression ou sur le 

bouton de sélection de mode Makoto pour revenir à la phase de sélection du mode 

Révision. 

 

12.2 Exportation et archivage 

Le Makoto Intravascular Imaging SystemÊ offre plusieurs méthodes et formats 

dôexportation des données depuis le système. Vous disposez de deux méthodes 

rapides configurables pour lôexportation et dôune méthode dôexportation personnalisée. 

Il est possible dôexporter une ou plusieurs procédures sélectionnées depuis le système, 

à des fins dôarchivage ou pour toute autre utilisation. Après avoir sélectionné les 

procédures souhaitées, utilisez le bouton « Export Destination » (Destination 

dôexportation) pour démarrer le transfert de données. 

 

 

Figure 12-7 : phase « Select » (Sélection) avec indication des boutons de destination dôexportation. 

 
Lorsque lôexportation est terminée, la liste de scans est actualisée et indique la 

destination dôarchivage dans la colonne « Archive Status » (État dôarchivage). 

 

12.2.1 Configurer les destinations dôexportation 

Les formats dôexportation et la compression par défaut peuvent être configurés pour les 

destinations PACS et supports amovibles (USB/DVD).  
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